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CONTACTING THE SONARDYNE SUPPORT TEAM 

24-hour Emergency Telephone Helpline: +44 (0) 1252 877600 

The Sonardyne 24-hour helpline is answered during normal UK office hours (08:00 to 17:00). 
Outside these hours, your call is automatically transferred to an agency, which logs the details of 
your emergency and alerts the appropriate Sonardyne personnel. 

Our aim is to make sure emergency requests are dealt with immediately during office hours, and 
are responded to within 30 minutes at all other times. 

Please note the helpline is for emergency use only. 

If you require NON-EMERGENCY product support, please contact your nearest Sonardyne office. 
Alternatively, contact the Sonardyne Head Office: 

Blackbushe Business Park 
Yateley 
Hampshire 
GU46 6GD 
United Kingdom 

Telephone: +44 (0) 1252 872288 

Fax: +44 (0) 1252 876100 

Email: support@sonardyne.com 

NOTE 

 Email and telephone support is available during normal UK office hours (08:00 to 17:00). 

mailto:support@sonardyne.com�
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SECTION 1 – INTRODUCTION 

1. Introduction 

This User Manual describes the safe installation, operation maintenance of the SPRINT System, 
with Sonardyne Transceivers and Beacons. The information and procedures within this manual are 
based on Sonardyne’s experience and knowledge. 

To make sure the safety of the installer and operator is maintained, it is important that all Warnings, 
Cautions and Safety Section in this manual, and the Warnings, Cautions and Safety Section of any 
additional manuals are read and understood. 

1.1 Related Publications 
To make sure the system is operated safely, a Safety Manual is supplied with this User Manual. It 
is important the Safety Manual is read and understood before proceeding with any activity on the 
equipment. 

The related publications are:  

Table 1-1 – Related Publications 

Publication Title 

Safety Manual Safety Manual 

UM-8084-101 Lodestar Hardware Manual 

UM-8084-107 Lodestar AHRS Manual 

UM-8080-109 Lodestar AHRS Messages 
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SECTION 2 – SAFETY 

2. Introduction 

Before any activity is carried out on this SPRINT system, it is recommended that the included 
Safety Manual and all Warnings and Cautions in this manual are read and understood.  

It is recommended the operator complies with the Health and Safety Regulations applicable to the 
vessel and the region before operating this equipment. 

Operators and service personnel must be familiar with the normal operating and safety procedures 
for Subsea Equipment. 

Documentation must be consulted whenever a  Warning symbol is found on the equipment, in 
order to determine the nature of the potential hazard and any actions which must be taken. 

If the equipment is used in a manner not specified by the manufacturer, the protection provided by 
the equipment may be impaired. 

2.1 Procedures 
Before carrying out any procedure on the SPRINT system make sure all the following Warnings 
and Cautions are read and understood. 

WARNINGS 

 Electric Shock Risk. Make sure the equipment is earthed before using. There is a risk 
of electric shock if the equipment is not earthed. 

 Electric Shock Risk. Disconnect power from the equipment before removing the 
covers. There is a risk of electric shock if the power is not disconnected. 

 Heavy Equipment. The 1000 metres rated Lodestar weighs 14 kg. Manual Handling 
Equipment (MHE) must be used to move the Lodestar. If MHE is not available, then a manual 
handling assessment must be carried out prior to carrying out manual lifting / handling. 
Personal Protective Equipment such as protective footwear and gloves must be worn when 
lifting this equipment. 

 Heavy Equipment. The 3000 metres rated Lodestar weighs 22 kg. Manual Handling 
Equipment (MHE) must be used to move the Lodestar. If MHE is not available, then a manual 
handling assessment must be carried out prior to carrying out manual lifting / handling. 
Personal Protective Equipment such as protective footwear and gloves must be worn when 
lifting this equipment. 

 Heavy Equipment. The 5000 metres rated Lodestar weighs 39 kg. Manual Handling 
Equipment (MHE) must be used to move the Lodestar. If MHE is not available, then a manual 
handling assessment must be carried out prior to carrying out manual lifting / handling. 
Personal Protective Equipment such as protective footwear and gloves must be worn when 
lifting this equipment. 

 



 

User Manual for SPRINT UM-8253-000
Issue A Rev 3

 

 

Section 2 
15 November 2013 3 

CAUTIONS 

 Incorrect Power Supply. Make sure the Lodestar is supplied with 24 or 48 V DC only. 
Do not use an AC power supply. 
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SECTION 3 – TECHNICAL DESCRIPTION 

3. Introduction 

Subsea Precision Reference Inertial Navigation Technology (SPRINT) is an acoustically aided 
inertial navigation system for subsea vehicles. The system extends the operating limits of Ultra-
Short Baseline (USBL) and can dramatically improve the operational efficiency of Long Baseline 
(LBL) by using sparse arrays. SPRINT makes optimal use of acoustic aiding data from acoustic 
positioning and other sensors such as Doppler velocity log (DVL) and pressure sensors. This 
improves position accuracy, precision and integrity in any water depth while reducing operational 
time and vessel costs. 

3.1 Lodestar 
The core of the system is the Lodestar platform. Lodestar was released to the market in 2007 as a 
premium quality, survey grade, Attitude and Heading Reference System (AHRS) for surface and 
subsea applications. Using the same hardware platform, Lodestar is fundamental to SPRINT. 

Lodestar makes use of three ring laser gyroscopes that measure the angular rate and three 
accelerometers that measure the specific force of a moving platform. The highest quality dual use 
(commercial and military) field proven sensors have been selected for use due to their 
performance, low mean time between failure (MTBF) and ease of export. These sensors have 
highly stable error characteristics and are compensated for temperature variation making them 
ideally suited to subsea applications. 

3.2 Inertial Navigation 
The INS sensor outputs are combined mathematically to compute the position, velocity and attitude 
of the vehicle. The output is extremely low noise and very accurate in the short term but slowly 
degrades over time. Therefore it is necessary to seamlessly aid the INS with complimentary 
acoustic positioning and other aiding sources. 

Acoustic Aiding with Sonardyne’s latest Sixth Generation (6G®) vessel-based transceivers and 
subsea beacons maximise the benefits of the system by providing the most precise and reliable 
acoustic aiding input. 

Depending on the functionality level of the SPRINT system being used, various aiding options will 
be available, whilst others may be disabled: 

 USBL 

 DVL 

 Pressure Depth 

 Zero Velocity (ZUPT) 

 LBL 

3.2.1 USBL Aiding 

The vessel-mounted USBL transceiver determines the range and bearing to an acoustic beacon 
fitted to the subsea vehicle. Using vessel DGPS for position and VRU/MRU/AHRS for vessel 
motion compensation, an absolute position for the vehicle mounted beacon is calculated by the 
USBL system. 
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This position is fed into SPRINT as an absolute positioning aiding input. Additionally, the USBL 
system is synchronised to Coordinated Universal Time (UTC) to provide an accurate timestamp. 
Whilst the use of Sonardyne USBL provides a tighter acoustic / inertial integration and the best 
possible USBL positioning performance, SPRINT can accept position aiding from any USBL system 
that uses correct time-stamped positions in an industry standard telegram. Although SPRINT 
improves USBL system precision and short term accuracy, it will not resolve any inherent 
systematic errors that are present. Users must therefore make sure the USBL system they are 
using is correctly calibrated and recommended operating practices are observed, for example, 
using regular sound velocity profiles. 

3.2.2 Sparse LBL Aiding 

In Sparse LBL operations, two or more (instead of four or five) beacons are deployed on the 
seabed and their positions derived using ‘box-in’ or other top-down calibration techniques. With a 
known beacon position, the INS can navigate in Sparse LBL mode using the ranges from one or 
more seabed deployed beacon to acoustically aid the INS and constrain error growth in the 
absolute position output. In this configuration, the vehicle mounted LBL transceiver (ROVNav 6) 
communications will be routed to the vessel via the Lodestar for optimal time stamping of acoustic 
range data. 

3.2.3 ZUPT (Zero Velocity) Aiding 

In certain operational situations the subsea vehicle will be static (e.g. during average position fixes). 
In these situations, particularly if there is risk of loss of other aiding, it is beneficial to be able to aid 
the INS with ‘zero velocity’ updates to estimate inertial sensor errors. This feature is available in 
SPRINT and is easily activated from the main user interface. 

3.2.4 Vehicle-Mounted Sensor Aiding 

Lodestar has the ability to use vehicle-mounted aiding sensors such as Doppler velocity logs (DVL) 
and pressure/depth sensors. The use of these sensors provides further benefits for subsea 
navigation such as the ability to provide precise and continuous navigation output even if external 
acoustic positioning is lost for periods of time. SPRINT does not need to be physically co-located 
with the Doppler Velocity Log or integrated into the same housing. Only ‘coarse’ alignments and 
offsets from the INS to the DVL are needed from the user. Fine offsets and misalignments are then 
calculated in the field using a calibration routine. This approach allows for more flexible mounting 
configurations to be considered. 

3.3 Theory of Operation 

3.3.1 Inertial Navigation 

Inertial navigation is the computation of velocity, position and orientation from measurements of 
acceleration and rotation. 

Acceleration (velocity change) is measured by an orthogonal triad of accelerometers. Rotation 
(angular change) is measured by an equally orthogonal triad of gyroscopes (see Section 3.3.2). 
The composite mechanical structure is called the Inertial Sensor Assembly (ISA). An Inertial 
Measurement Unit (IMU) is composed of the ISA and a processor that performs various forms of 
compensation using e.g. factory calibration coefficients. The outputs of an IMU are compensated 
delta angles and delta velocities typically at a rate of 100-200Hz.  

Inertial navigation is based on the dead-reckoning principle. INS velocity is computed from an initial 
value by integration (see Figure 3-1) of acceleration over time. Similarly, position is computed from 
velocity and orientation (attitude and heading) is computed from integration of measured rotation 
(angular change). 
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Figure 3-1 – Computation of Velocity via integration of Acceleration (1D example)** 

 
 
It can be imagined how a fixed error (bias) in acceleration when integrated will cause an error in 
velocity that grows proportionally with time giving rise to quadratic with time error in position.  

This simplified description of the inertial navigation process match fairly well in the short term 
especially for stable platform INS where the accelerometers were physically pointed in fixed 
directions (e.g. North, East and Down). In practise, the 3D vector mathematics are somewhat more 
involved, especially for modern strap-down INS where the sensors are strapped onto the vehicle 
body. 

** Velocity at time ‘t’ is the sum of the areas under the acceleration curve (yellow counts as 
negative) plus the initial velocity at time t0. 

3.3.2 Inertial Sensors 

Accelerometer: Most accelerometers used for inertial navigation are of the force-feedback 
pendulous type illustrated in Figure 3-2. A proof mass at the end of a pivoted or flexible arm is 
balanced via feedback control keeping its deflection close to zero. The coil current generating the 
counter acting force is a measure of acceleration along the single axis of free movement. 

Figure 3-2 – Force Feedback Pendulous Accelerometer 
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It is impossible to distinguish between true kinematic acceleration (velocity change relative to the 
Earth) and gravity. A stationary accelerometer with its sensitive axis pointed up will measure +1g 
even though it is obviously not moving anywhere. The term specific force is the sum of kinematic 
acceleration and gravity and has been coined to express what an accelerometer really measures. 

Gyroscope: Modern gyroscopes are based on a variety of different physical principles. Most 
navigation grade gyroscopes are currently based on optics using the “Sagnac” effect to sense 
rotation, e.g. the Ring Laser Gyro (RLG, see Figure 3-3): 

Laser beams are made to travel in both opposite directions within a cavity (“ring”) formed by 
typically 3 or 4 mirrors. When the cavity rotates relative to inertial space one beam has to travel 
further than the other. A part of the laser light is allowed to escape via a semi-transparent mirror 
and is used to form a fringe pattern. Optical sensors count the direction and number of fringes 
passed which is a precise (digital) measure of how much RLG has rotated relative to inertial space.  

In a Fibre Optic Gyroscope (FOG) light travels through loops of optic fibre rather than a closed 
path. Both RLG’s and FOG’s can achieve very high performance.  

Other commonly used gyro technologies are: 

 Conventional spinning metal gyroscope 

 “Dynamically Tuned Gyro” (DTG). Ingenious compact mechanical strap down device.  

 Hemispherical Resonator Gyro (HRG). Resonant device made of very high Q quartz 
(“Wine glass”) – Coriolis force device  

 Micro Electro-Mechanical Devices (MEMS) based gyros (Coriolis force) 

Figure 3-3 – Ring Laser Gyroscope Principle of Operation 

 
 

3.3.3 Strap-down Inertial Navigation 

The process of strap-down inertial navigation is shown in Figure 3-4. Vehicle orientation relative to 
the Earth is maintained within the navigation computer via integration of measurements from the 
gyroscope triad and is compensated for Earth rotation and vehicle motion over the surface of the 
Earth. Known orientation is used to transform accelerometer specific force into a navigation frame 
(often North-East-Down – NED). 
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Specific force is compensated for gravity and Coriolis force to obtain kinematic acceleration. Gravity 
is computed using a mathematical model and is dependent on vehicle position on the Earth, most 
importantly latitude and depth/height. Coriolis force is a “mathematical artefact” that arises and 
requires compensations because the navigation frame rotate with the Earth and is therefore not a 
true inertial frame (fixed relative to the stars). Finally, acceleration is integrated to obtain velocity 
and velocity is integrated into position.  

Typically the strap-down computations are set to execute at 100-200Hz whereas the inertial 
sensors may be sampled at several kHz. The raw rate is reduced using a coning and sculling 
algorithm that e.g. very precisely takes into account the non-commutativity of rotations (sequence 
of rotations matter). 

Figure 3-4 – “Strap-Down” Inertial Navigation 

 
 

3.3.4 Errors in Inertial Navigation 

The sources and error propagations in inertial navigation are complex and not always intuitive. The 
initial part of Section 3.3.1 describes how a constant error in acceleration would cause error in 
position to grow with time squared. In a real INS with external aiding (as described in Section 
3.3.7) a fixed accelerometer bias would primarily cause an error in roll/pitch which would make 
gravity couple into the horizontal plane by just enough to counteract the position drift.  

Simulation techniques and tools are available for accurately predicting INS performance in various 
scenarios and taking all significant error sources into account. Somewhat counter intuitively, 
gyroscope errors in general play a more significant role than accelerometer errors. 

3.3.5 Reference frames 

A number of reference frames are used within inertial navigation. 

Vehicle frame: Axes are along the vehicle axis, typically forward, starboard and down. The vehicle 
frame is typically used for navigation outputs (e.g. roll, pitch and heading) and for defining various 
sensor lever arms (“offsets”) and mounting angles.  

IMU frame: Axes are along the inertial sensor axes as typically marked on the IMU/INS housing. 
IMU frame is used for many INS internal computations. 
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Navigation frame: Frame used for the inertial navigation computation of position and velocity 
(most often local level e.g. North, East and Down). 

Inertial frame: Non-rotating frame (relative to inertial space).  

NOTE 

Definitions of SPRINT (and Lodestar) specific reference frames are provided in Appendix A 
and Appendix B. 

3.3.6 Gyrocompassing – North Finding 

An INS can determine its orientation (roll, pitch and heading) relative to the Earth by 
“gyrocompassing”. Basically the direction of up/down and the Earth spin axis can be sensed using 
the inertial sensors.  

For a slow moving (i.e. marine) vehicle, the measured acceleration (specific force) vector will point 
“up”, i.e. the measured vector will be parallel with the local gravity vector (down). In practise, 
measured acceleration is averaged (filtered) to cancel out effect of vehicle motion.  

The local gravity vector will follow the rotation of Earth relative to inertial space, see Figure 3-5. 
The direction of East can be determined by tracking the systematic change in the direction of the 
gravity vector relative to inertial space over time. Knowing the direction of down and East allows the 
direction of North and full orientation to be determined. 

Figure 3-5 – Earth Rotation 

 
 
The Earth rotates by just 15 deg/hour and the gyroscopes used for tracking the change of direction 
of gravity must be accurate to considerably better values. Furthermore, it can be shown that the 
local gravity vector direction changes only by the cosine of Latitude part of Earth rotation, i.e. 
change is reduced towards the Poles. This explains why heading accuracy is typically specified as 
x.xxx degrees * Secant Lat (secant = 1 / cosine).  
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Vehicle position change in the N/E direction (from, e.g. steaming) will cause the gravity vector to 
change in this direction also and not be pure E/W. This will bias the gyro-compassing determined 
heading if not compensated for by e.g. measurements from a GPS receiver.  

An inertial based Attitude and Heading Reference System use the described principles to generate 
robust roll, pitch and heading. 

3.3.7 Aided INS 

The drift of a typical commercial airplane inertial system is on the order of 1NMPH (Nautical Mile 
Per Hour). This is adequate for guidance from one airport to another and e.g. crossing the Atlantic 
but hardly useful for navigation of slow moving marine vehicles intended to do e.g. seabed 
mapping.  

Improved performance can be achieved by Aiding the INS with measurements from one or more 
external sensors; see Figure 3-6. IMU data feeds into two separate algorithms: AHRS and AINS. 
The AHRS is used as a convenience for providing the AINS with initial estimates of attitude/heading 
thereby simplifying its design. 

The INS block was described in Section 3.3.3 and provides the position, orientation and velocity 
output. The role of the error state Kalman filter is to estimate and compensate errors in the inertial 
navigation and thereby constantly keep the INS on track, while monitoring the correction feed.  

The Kalman filter determines INS errors from external sensor measurements. The difference 
between a measurement (observation) and its expected value (based on the INS) is fed into the 
Kalman filter and is used to refine its state vector and covariance matrix. The state vector is 
composed of INS errors in position, orientation and velocity and often also key inertial sensor errors 
such as gyroscope and accelerometer bias. Errors in external sensors can also be modelled for 
improved performance.  

The covariance matrix is the “memory” of the Kalman filter and it holds the uncertainty of each state 
and the correlation between states. Useful performance metrics such as expected positioning 
accuracy is extracted directly from the covariance matrix. 

The Kalman filter will manage asynchronous data and the considerable latency often found in 
acoustic observations. An Aided INS is often referred to as a “hybrid inertial system”.  

The combination of a DVL and INS provides accurate heading/attitude and the ability to perform 
dead-reckoning to an accuracy of just a few meters per hour. This functionality is extremely useful 
for subsea navigation. Further combination with USBL or (sparse) LBL provides absolute 
positioning that is considerably more accurate and robust than acoustic positioning by itself. 
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Figure 3-6 – Sonardyne “Lodestar” Acoustically Aided INS functional block diagram 

 
 
The INS aiding options available in SPRINT are listed in Table 3-1. Only certain position aiding 
inputs, such as USBL can be used to initialise Inertial Navigation and that these aiding inputs must 
be UTC time synchronised. 

Table 3-1 – SPRINT INS Aiding Options 

Aiding Source Aiding Type Aiding Considerations 

 
Position 
Aiding 
(Horizontal) 

Velocity 
Aiding 

Depth Aiding 
(Vertical) 

Time Sync 
Required? 

Can be 
used to 
Initialise 
INS? 

USBL      

LBL      

DVL      

Zero Velocity      

Pressure Depth      

 

NOTE 

 Pease note and follow the operational considerations provided below: 

    * LBL aiding must be used in conjunction with DVL Aiding. 

    * LBL and Zero Velocity (ZUPT) aiding are only available in the full version of SPRINT. 
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3.4 System Architecture 

3.4.1 Architecture 

The architecture of the SPRINT system is shown in Figure 3-7. 

Figure 3-7 – Logical SPRINT Architecture 

 
 
The Navigation PC runs the SPRINT software which comprises two components: 

 User Interface, which provides configuration, control and monitoring of the Lodestar and 
SPRINT system. 

 SPRINT Server, which routes all communications between the Lodestar, User Interface 
and any other topside external devices. The SPRINT server also logs all data from the 
Lodestar on the Navigation PC, including raw sensor feeds. 

The Lodestar Communications Hub (LCH) is a serial device server and Ethernet hub used by the 
Navigation PC. An Ethernet link is provided between the Navigation PC and the LCH (ports). For 
this reason IP Addresses and Ports are used to specify serial as well as Ethernet devices 
connected to the LCH. The IP addresses of each of the main system components are shown above 
but note that the Lodestar IP address will only be used if the Lodestar is to be connected to the 
topside components using an Ethernet connection. 

External devices may be connected directly to the Lodestar as well as to the LCH. 

The SPRINT system stores the configuration of the Lodestar and Software/Server. A Factory 
(default) Configuration is provided as a starting point for setup. Thereafter a User Configuration is 
stored by the software every time a configuration change is made or by user request. If the 
Lodestar used by the SPRINT system is swapped, the software will prompt the user to re-apply the 
User Configuration to the new Lodestar to continue operation as before. 
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As well as storing the log files in real time on the Navigation PC, the Lodestar also stores a rolling 
backup of all the log files on its onboard SD card. The size of the log data is variable depending on 
the number/update rate of aiding sensors and also the number of outputs specified. Typically for a 
USBL/DVL/Depth aided system, the log files are populated at the rate of 0.5mb per minute, which 
will provide over 10 days continuous onboard storage. The log files on the Lodestar SD card can be 
retrieved offline using the Lodestar PC Utility (see Lodestar AHRS Manual UM-8084-107 for 
instructions).  

 

 

 



 

User Manual for SPRINT UM-8253-000
Issue A Rev 3

 

 

Section 4 
15 November 2013 14 

SECTION 4 – PLANNING 

4. Planning 

4.1 Navigation Scenario 
Prior to installation it is important to consider the navigation scenario to determine the optimum 
system configuration and interfaces. Typically the scenario is defined by the positioning (or attitude) 
accuracy specifications of a mission or project but equally important is the timeliness (or latency) of 
positioning or attitude provided by SPRINT system. 

Two common navigation scenarios are explained below. The recommended configuration for each 
navigation scenario is explained in the installation and configuration sections. If there is uncertainty 
as to which scenario is to be supported it is recommended that ‘Dynamic Survey’ is selected. 

4.1.1 Construction Survey 

In this scenario the SPRINT ROV will be used to position subsea structures or pipelines that are 
slow moving. The positioning and attitude accuracy tolerances can be high but the timeliness 
requirements of the outputs is relatively low (<~ 0.5 seconds) as ROV is often moving very slowly 
or performing static fixes during critical positioning phases. 

4.1.2 Dynamic Survey 

In this scenario the SPRINT ROV will be used to perform dynamic, high accuracy surveys such as 
multibeam pipeline out-of-straightness. The positioning and attitude accuracy tolerances are high 
and so is the timeliness of the outputs as the ROV motion must be compensated correctly when 
processing multibeam data. Any significant latency in ROV position or attitude will result in errors or 
artefacts in the final multibeam terrain model. In this scenario accurate alignment and instrument 
offsets will be more critical than in the ‘construction’ survey. 
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4.2 Interfaces 
Prior to installation the following interfaces should be planned according to the SPRINT navigation 
scenario (indicates a supported interface,  indicates a non supported interface): 

  Navigation Scenario 

Interface*  Construction Dynamic 

Lodestar Connection Either:   

Ethernet (100mbit only)    

Serial RS232 115,200 baud   

Time Synchronisation** Either:   

GPZDA UTC message with configurable latency to 1 PPS   

GPZDA UTC message & 1PPS sent to Lodestar   

USBL Aiding*** Either:   

PSIMSSB message (UTC time, WGS 84 Lat/Long Radians)   

USBL GGA message (UTC time, WGS 84 Lat/Long Degrees)   

DVL Aiding**** Either:   

RDI Binary PD4/5 Message (Recommended)   

RDI Binary PD0 Message   

Pressure Depth Aiding One Of:   

DigiQuartz kPA/PSI/Metres   

Valeport Midas SVX2   

NMEA DPT message   

Sonardyne SONDEP message   

Tritech Winson (processed) message)   

LBL Aiding    

Fusion 6G LBL 1.11.04 (or later) with appropriate dongle   

INS Position Output (with UTC timestamp) Either:   

From SPRINT topside (LCH)   

From Lodestar (ROV)   

AHRS Attitude Output (No UTC timestamp) Either   

From SPRINT topside (LCH)   

From Lodestar (ROV)   
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NOTES 

 *See Appendix E for all message formats. 

** It is assumed that in either mode of time synchronisation that the GPZDA message is 
received no faster than 1Hz (once a second) otherwise the system may not be able to 
synchronise. 

*** All USBL aiding inputs must be raw / measured and should not be subject to any filtering. 

**** See Appendix D for supported DVL configurations. 
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4.3 Connections 
To guarantee the successful operation of the SPRINT system, the system connectivity must be 
considered at the installation planning stage. A suggested system connectivity diagram for the 
‘construction survey’ configuration is shown in Figure 4-1. 

Figure 4-1 – Construction Survey Interface Diagram 
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A suggested system connectivity diagram for the ‘dynamic survey’ configuration is shown in  
Figure 4-2. 

Figure 4-2 – Dynamic Survey Interface Diagram 
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4.4 Cabling 
The system cabling must be carefully planned prior to installation to avoid issues. Subsea cables 
can be costly and time consuming to correct or replace during the installation phase. 

4.4.1 Topside 

The majority of topside interfaces will be serial. Consideration should be given for any serial cable 
run length, as this could lead to data corruption if the length is excessive, particularly the serial 
connection between the SPRINT LCH and the Lodestar (if used). If the distance between the 
SPRINT LCH and the ROV (de) multiplexer is excessive for an 115,200 baud rate RS232 serial link 
then alternate interfaces should be planned to make sure the data is not corrupted, such as Serial 
to Ethernet or RS232 to RS422/485 converters. Alternatively an Ethernet connection to the 
Lodestar could be considered.  

4.4.2 Subsea 

A typical cabling diagram for all the required subsea connections to and from the Lodestar on the 
vehicle is provided in Appendix F. This diagram should be used to produce vehicle and sensor 
specific SPRINT cables prior to installation. If required, there are also individual cable pin-outs for 
each specific Lodestar port available in the Lodestar Hardware Manual UM-8084-101. 

4.5 Time Synchronisation 
The SPRINT Lodestar will be time synchronised to UTC by receiving a ZDA message and 
optionally a 1PPS timing pulse from a GNSS receiver. The SPRINT system will be interfaced to 
other systems, such as USBL, Survey Software or Multibeam that are also time synchronised to 
UTC using connections to GNSS receivers. A common source of perceived INS position error is 
inconsistent time synchronisation across the various systems interfaced with the SPRINT system. 

There are three fundamentally different types of GNSS ZDA/1PPS time synchronisation: 

 ZDA arrives before its associated 1PPS 

 ZDA arrives after its associated 1PPS (most common) 

 1PPS and ZDA are asynchronous (seen with many modern GNSS systems) 

Different models and configurations of GNSS receiver may use any of the three types listed above. 

It is very important that the type of synchronisation used by each GNSS receiver is understood prior 
to SPRINT installation to avoid timing issues. This may require consultation with the GNSS 
manufacturer. If possible, the use of a common GNSS receiver for time synchronising all systems 
will greatly reduce the risk of issues. 

4.6 Depth 
The SPRINT system supports either pressure or depth aiding input to determine the depth of the 
INS. There are several factors that should be considered during the planning phase. 

4.6.1 Pressure to Depth Conversion 

In the case of a pressure aiding input the Lodestar performs a simple pressure to depth (metres) 
conversion. The pressure to depth conversion scale factors are provided in Appendix G. 
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If there is a requirement for a different pressure to depth conversion calculation to be used, the 
operator can either: 

 Convert the pressure sensor data to metres using the required conversion and pass this 
to the Lodestar as a depth (m) aiding message. 

 Apply a pressure depth offset to the SPRINT system at operating depth so the INS 
depth is consistent with the intended depth datum. 

 Convert the INS depth output from the system to another datum using the provided 
conversion calculations. 

4.6.2 Surface Pressure 

Most pressure sensors will measure ambient air pressure at the surface. This is the equivalent of 
approximately 10 metres of water depth. SPRINT allows the operator to measure the surface 
pressure on deck and remove it from any subsequent depth calculation. Depending on project 
requirements surface pressure may be removed as described above or the INS depth could also 
include surface pressure – this should be decided at the planning strange. 

4.6.3 LBL References 

Whichever method or configuration of SPRINT pressure depth is used, the INS depth should 
always be consistent and relatively accurate to any LBL reference depths. 

4.7 (Sparse) LBL Array Planning 

4.7.1 Features and Operational Guidelines 

The INS can be aided by LBL range observations from a Fusion 6G system. 

Due to its DVL-inertial dead-reckoning capability, the INS can manage with less than the 4 or 5 
beacons traditionally required for acoustic LBL tracking, hence the term ‘Sparse’ LBL. 

Please consider the following features and operational guidelines for sparse LBL: 

a. The minimum number of beacons at one site is two. Use of three beacons will support 
loss of acoustics to any single beacon and INS integrity if there is an error with aiding 
from any single beacon. For this reason the recommended number of beacons for a 
sparse array is three. 

b. In specific scenarios with favourable vehicle dynamics / trajectory the INS can be aided 
with range observations from just a single beacon. Additional operational guidelines 
should be considered – contact Sonardyne for advice.  

c. The INS can be actively aided by up to 6 beacons but can record LBL aiding 
observations for up to 10 beacons for analysis and post processing. 

d. Acoustic update rate to each beacon should be faster than 10 seconds – this is 
primarily for screening of observations prior to INS use.  

e. Pressure depth provided to the INS and beacon depths should be consistent. Relative 
depth errors will cause error in INS positioning if line of sight is not horizontal.  

f. Sound velocity in Fusion must be correct. Make regular updates if change is expected 
(> 0.5m/s).  

g. LBL (range) aiding must be used in conjunction with DVL aiding, particularly in very 
sparse arrays. Contact Sonardyne for specific guidance if DVL is not available. 

h. Make sure placement of LBL aiding beacons provides adequate acoustic line of sight 
and good geometry to the LBL transceiver during planned operations. 
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4.7.2 Sparse Array Geometry 

The reference beacons in the sparse array should be placed so the line of sight to at least two of 
the beacons is approximately orthogonal to reduce the error in opposing directions. 

An example of good geometry is shown below in Figure 4-3 and examples of poor array geometry 
are shown below in Figure 4-4. 

Figure 4-3 – Example of Good Sparse Array Geometry 

 
 

Figure 4-4 – Examples of Poor Sparse Array Geometry 

 
 

4.7.3 First Use of ‘Sparse’ LBL Aided INS 

It is recommended that with first use of ‘Sparse LBL Aiding’, full LBL array navigation is also 
available to provide an independent position reference. Refer to the procedure detailed below: 

1. Deploy a full LBL array. 

2. Run full LBL acoustic tracking in Fusion. 

3. Use SPRINT with LBL aiding from two or more of the array beacons (depending on 
operational requirements). 

4. Compare the positioning performance of SPRINT sparse LBL against full acoustic LBL. 

Gross difference between the two positions will indicate an issue for investigation/resolution; see 
Section 12.9 for troubleshooting advice. 
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4.8 Check List 
Use the list below to assist in making sure the planning for the SPRINT system is complete prior to 
system installation: 

 
Action 

Manual 
Section 

Checked

1 Plan navigation scenario 4.1  

2 Plan (and prepare) required interfaces 4.2  

3 Plan system connections 4.3  

4 Plan system cabling 4.4  

5 Plan system time synchronisation 4.5  

6 Plan system depth 4.6  

7 Plan sparse LBL array(s) if required 4.7  

Sign: 
…………………………………………………….. 

Date: 
……………………………………………….. 
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SECTION 5 – INSTALLATION 

5. Installation 

5.1 SPRINT System Kit 
The SPRINT system kit should comprise the following items: 

Figure 5-1 – SPRINT Installation Kit 

 
 

 Lodestar   Lodestar Cable Tails 

 Navigation PC   Lodestar Test Cables 

 Lodestar Communications Hub (LCH)   Lodestar Mounting Plate (not shown) 
 

5.2 Mounting Lodestar 
The Lodestar should be installed on the vehicle as per the instructions below. 

WARNINGS 

 Electric Shock Risk. Make sure the equipment is earthed before using. There is a risk 
of electric shock if the equipment is not earthed. 

 Electric Shock Risk. Disconnect power from the equipment before removing the 
covers. There is a risk of electric shock if the power is not disconnected. 

 Heavy Equipment. The 1000 metres rated Lodestar weighs 14 kg. Manual Handling 
Equipment (MHE) must be used to move the Lodestar. If MHE is not available, then a manual 
handling assessment must be carried out prior to carrying out manual lifting / handling. 
Personal Protective Equipment such as protective footwear and gloves must be worn when 
lifting this equipment. 
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WARNINGS 

 Heavy Equipment. The 3000 metres rated Lodestar weighs 22 kg. Manual Handling 
Equipment (MHE) must be used to move the Lodestar. If MHE is not available, then a manual 
handling assessment must be carried out prior to carrying out manual lifting / handling. 
Personal Protective Equipment such as protective footwear and gloves must be worn when 
lifting this equipment. 

 Heavy Equipment. The 5000 metres rated Lodestar weighs 39 kg. Manual Handling 
Equipment (MHE) must be used to move the Lodestar. If MHE is not available, then a manual 
handling assessment must be carried out prior to carrying out manual lifting / handling. 
Personal Protective Equipment such as protective footwear and gloves must be worn when 
lifting this equipment. 

 

CAUTION 

 Incorrect Power Supply. Make sure the Lodestar is supplied with 24 or 48 V DC only. 
Do not use an AC power supply. 

 

NOTES 

 It is not necessary to mount the Lodestar at the vehicle centre of rotation/gravity. 

 The Lodestar should be mounted very securely to the vehicle in a rigid location. It 
should not be mounted on a moveable tray or in locations with excessive mechanical noise 
(e.g. directly next to hydraulic pumps). 

The default mounting for the Lodestar is in the vertical position – refer to Figure 5-2. 

Figure 5-2 – Lodestar Nominal Mounting 
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In this arrangement the X-axis indicator on the top of the Lodestar is aligned with the forward 
direction of the vehicle reference frame and the Y-axis indicator is aligned with the starboard 
direction of the vehicle reference frame (refer to Figure 5-3). 

Figure 5-3 – Lodestar Axis Indicators 

 
 
A mounting plate is supplied with the SPRINT system kit to support the mounting arrangement. 

The Lodestar can also be mounted in other orientations if required. A common alternative mounting 
is with the Lodestar orientated horizontally as shown below in Figure 5-4. 

Figure 5-4 – Lodestar Horizontal Mounting 

 
 

The standard SPRINT system kit does not include mounting brackets or plates to support this 
orientation but optional mounting brackets can be ordered from Sonardyne on request. Please 
contact Sonardyne Support for further details. 

Additional Lodestar power, maintenance and installation guidelines are provided in Lodestar 
Hardware Manual UM-8084-101. 
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5.2.1 Alignment 

For the Lodestar and SPRINT system to provide accurate attitude and positions with respect to the 
vehicles reference frame, any misalignment between the Lodestar and vehicle reference frame 
must be corrected by determining and applying Lodestar mounting angles in the SPRINT system. A 
definition for the Lodestar reference frame including mounting angle convention is described in 
Appendix B. Typically there are two stages in determining the Lodestar Mounting angles. 

First determine the initial ‘coarse’ mounting angles. If the Lodestar mounting is default as described 
in Section 5.2 then the Lodestar mounting angles will all be zero. If the Lodestar mounting is non-
default (e.g. the Lodestar is mounted horizontally) then the mounting angles must be applied in the 
SPRINT system. A selection of Lodestar mounting orientations and related mounting angles are 
provided in Appendix C. 

Once the (coarse) mounting angles of the Lodestar have been determined using the guidance 
provided above, the angles can be refined using existing methods for ‘Gyro to ROV’ calibration. 

These methods may include: 

 Manual calculation using traditional survey methods such as a dimensional control 
survey (usually performed in a static environment onshore). 

 Automated calculation provided by Survey software using comparison of ROV gyro 
against vessel reference gyro (can be performed offshore in a dynamic environment). 

Make sure the results of any additional mounting angle calculation match the conventions listed in 
Appendix B before they are applied to the SPRINT system. 

5.3 Mounting Aiding Sensors 
All aiding sensors must be mounted very securely to the vehicle in a rigid location. They should not 
be mounted on moveable arms or trays as this may seriously degrade SPRINT performance by 
providing inaccurate or imprecise aiding data. 

5.3.1 Doppler Velocity Log (DVL) 

The SPRINT system is provided with a software utility that will calculate the mounting angles of the 
DVL used with the system. Therefore a variety of mounting angles can be supported but the 
SPRINT default DVL configuration (See Appendix C) will assume the DVL is mounted with the 
transducers facing towards the seabed and the alignment mark (also referred to as navigational 
groove) aligned to the forward direction of the vehicle reference frame. 

Figure 5-5 – DVL Alignment 
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5.4 Measuring Lever Arms 
Typically a vehicle has a central reference point or CRP and position calculations for a vehicle 
should be made with respect to this point. SPRINT will automatically provide the INS position for 
the defined vehicle CRP (and up to two additional remote positions if required). 

The lever arms from the vehicle CRP to the Lodestar and any aiding sensors such as DVL, 
Pressure Depth and USBL beacon must be measured. 

NOTES 

 One of the most common sources of error in INS positioning is incorrect lever arms. 

 It is recommended that all measurements are carried out by at least two (ideally three) 
individuals and the results compared. 

 Lever arms must be measured to the point of reference on each aiding sensor. If the 
point of reference is unknown, consult the relevant product manual. 

5.4.1 Lodestar Lever Arm 

The Lodestar lever arms must be measured from the vehicle CRP to the Lodestar ‘centre of axis’. 
The location of the ‘centre of axis’ for each of the three subsea housing types are shown below (all 
dimensions are in millimetres). 

Figure 5-6 – 1000 m Lodestar Centre of Axis Location 

 
 

Figure 5-7 – 3000 m Lodestar Centre of Axis Location 
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Figure 5-8 – 5000 m Lodestar Centre of Axis Location 

 
 

5.5 Connecting the Equipment 
Before proceeding with any action make sure all Warnings and Cautions, and the Safety section in 
this manual are read and fully understood. The equipment interfaces should have been defined 
during Interface Planning, Section 4.2. A full set of Lodestar test cables and cable tails are 
supplied with the SPRINT system. It is assumed that vehicle and instrument specific interface 
cables have already been made using guidance provided in Planning, Section 4.4.2, Subsea. Use 
the following procedure to connect the equipment. 

1. Refer to Figure 5-9. Connect the vehicle power cable to the Console Port (CP) connection  
on the top of the Lodestar. 

Figure 5-9 – Lodestar Connection Points 

 
 

 Console Port (CP)  Port (T1) 

 Port (C1)  Port (T2) 

 Port (E1)    
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2. If a Pressure Depth Sensor is to be connected to the Lodestar, connect to Port C1 . 

3. For Ethernet communications and/or a 1PPS pulse, connect the vehicle to the Lodestar  
Port E1 . 

4. If a Doppler Velocity Log is to be connected to the Lodestar, connect to Port T1 . 

5. If an LBL Transceiver is to be connected to the Lodestar, connect to Port T2 . 

6. Refer to Figure 5-10. Connect the Navigation PC  to the LCH  using the Ethernet Cable 
. A label on the Navigation PC will indicate which Ethernet port to use. 

Figure 5-10 – Connecting the Navigation PC to the LCH 

 
 

 Navigation PC  LCH

 Ethernet Cable    
 

7. Refer to Figure 5-11. The Lodestar  can be connected to the LCH  by two methods: 

NOTE 

 If the Lodestar serial connection length is excessive, data may be corrupted, see 
Section 4.4.1 for guidance. 

 An Ethernet cable  connected to the Ethernet connection point 2 on the LCH and 
connection C2 on the Lodestar. 

 A serial port cable  connected to serial port 1 on the LCH and connection CP on the 
Lodestar. 
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Figure 5-11 – Connecting the Lodestar to the LCH 

 
 

 LCH   Serial Port Connection 

 Ethernet Cable connection  Lodestar 
 

8. Refer to Figure 5-12. Additional equipment can be connected to the serial points at the rear 
of the LCH . 

 To add a GPZDA feed  from the vessel GPS, connect to serial port 3  on the LCH. 

 To add a USBL position feed  from the vessel USBL system, connect to serial  
port 4  on the LCH . 

 To add a Pressure Depth  input to the topside, connect to serial port 5  on the  
LCH . 

 To add a 1PPS timing pulse from the vessel GPS, connect to 1PPS In Port  on the 
LCH. Then send the pulse to the Lodestar by connecting to 1PPS Out Port . 
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Figure 5-12 – Adding Additional Equipment to the LCH 

 
 

 LCH   GPZDA feed   Serial Port 3 

 1PPS In Port   USBL position feed   Serial Port 4 

 1PPS Out Port   Pressure Depth Input   Serial Port 5 
 

5.6 SPRINT Software 
The Navigation PC is supplied pre-installed with the SPRINT software; if the software is not 
installed instructions for installation and updates are supplied below: 

1. Log into the PC administrator user account. 

2. Insert the SPRINT software CD into the CD drive of the Navigation PC.  

3. Run Setup.EXE from the CD drive.  

4. Follow the instructions provided by the software installation tool. 

5.7 Lodestar Firmware 
The Lodestar supplied with the SPRINT system will be pre-configured with the correct firmware for 
operation with the SPRINT system. See UM-8084-101 Lodestar Hardware Manual for detailed 
instructions on the method for firmware upgrade. If you are unsure if your Lodestar is running the 
correct firmware version for use with SPRINT contact Sonardyne Support. 
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5.8 Check List 
Use the list below to assist in the system installation, prior to the configuration: 

 Action 
Manual 
Section 

Checked

1 Check system kit contents 5.1 
 

2 Install Lodestar 5.2 
 

3 Determine equipment alignment 5.3 
 

4 Measure instrument offsets 5.4 
 

5 Connect equipment interfaces 5.5 
 

Sign: 
…………………………………………………….. 

Date: 
……………………………………………….. 

 

NOTE 

 See Appendix H for a full step-by-step installation and setup checklist that can be 
printed and used as a hard copy reference. 
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SECTION 6 – CONFIGURATION 

6. Configuration 

6.1 Changing the Lodestar Console Port (CP) Baud Rate 
If the Lodestar is to be connected using a serial interface, the baud rate for the console port must 
be 115200. Lodestars shipped as part of a SPRINT system will be pre-configured with this baud 
rate. If the Lodestar has not been pre-configured for this baud rate, the Lodestar PC utility software 
can be used to configure the console port baud rate, see UM-8084-107 Lodestar AHRS Manual 
for instructions. 

6.2 Configuring Lodestar Communication Hub (LCH) 
The LCH provides an 8-port serial device server interface for the SPRINT system. 

Figure 6-1 – LCH front face 

 
 

Figure 6-2 – LCH rear face 

 
 
The LCH can provide a variety of configurable serial settings for each serial input device or output 
port required topside, such as: 

 Baud rates from 50 to 921,600. 

 RS-232, RS-422, RS-485 Half Duplex or RS-485 Full Duplex. 

 Data bits, Stop bits, parity, flow control and FIFO. 

The LCH also contains a 1PPS conditioner that can be used to condition and boost the 1PPS 
signal before it is sent to the Lodestar. 
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The LCH is supplied pre-configured with the following settings for serial input/output interfaces: 

Table 6-1 – Serial Input / Output Interfaces 

LCH 
Port 

Local 
TCP 
Port 

Purpose 
Baud 
Rate 

Data 
Bits 

Stop 
Bits 

Parity FIFO 
Flow 

Control 
Interface

Port 1 5001 
Lodestar 
Console 
Port  

115200 8 1 None Enable None RS-232 

Port 2 5002 GPS Input 9600 8 1 None Enable None RS-232 

Port 3 5003 ZDA Input 9600 8 1 None Enable None RS-232 

Port 4 5004 
USBL 
Input 

9600 8 1 None Enable None RS-232 

Port 5 5005 
Depth or 
S.V. Input 

9600 8 1 None Enable None RS-232 

Port 6 5006 
Primary 
Output 

9600 8 1 None Enable None RS-232 

Port 7 5007 
Secondary 
Output 

9600 8 1 None Enable None RS-232 

Port 8 5008 
DO NOT 
USE 

       

 
If it is necessary to modify any setting for system operation, follow the procedure below: 

NOTE 

 The LCH Port 1 is pre-configured to match the default serial connection configuration of 
Lodestars used with SPRINT systems. If this Port needs to be modified, the default Lodestar 
connection configuration will need to be changed. It is advised that Sonardyne Support are 
contacted for further instructions. 

It is necessary to know the IP address of the LCH unit. At the time of manufacture the IP address is 
set to 192.168.179.51. The IP address can be discovered as follows: 

1. Open NPort Administrator by navigating from the start menu: Programs > NPort 
Administration Suite > NPort Administrator. 
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2. Refer to Figure 6-3. Click the Search button on the toolbar and wait 5 seconds for the search 
to complete. The model and IP address of the LCH comms unit will appear. In the example 
below the IP address is 192.168.179.51. 

Figure 6-3 – LCH Comms IP Address 

 
 

NOTE 

 The LCH factory default IP address is 192.168.179.51. 

3. Once the IP address is known, open Internet Explorer. 

4. Enter the LCH IP address into the address bar e.g. http://192.168.179.51. 

5. Refer to Figure 6-4. A web configuration page will be shown. 

Figure 6-4 – Web Configuration Page 

 
 

6. Refer to Figure 6-5. To change any of the port settings, expand the Serial Settings item in 
the left hand pane. 
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Figure 6-5 – Port Serial Settings 

 
 

7. Refer to Figure 6-6. Select the port to be configured; the current settings will be shown in the 
right hand pane. 

Figure 6-6 – Serial Settings 

 
 

8. Change the settings as required and then click Submit to save the settings.  

9. Refer to Figure 6-7. Click Save/Restart and wait approximately 30 seconds for the changes 
to be applied and the LCH to restart. The LCH will beep twice when it is ready.  

Figure 6-7 – Save Serial Settings 

 
 

10. When all changes have been made close Internet Explorer. 
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6.3 SPRINT Software Configuration 

Refer to Figure 6-8. Insert the security dongle into the Navigation PC then open the SPRINT 
software by double clicking on the SPRINT application desktop icon: 

Figure 6-8 – SPRINT Software icon 

 
 

6.3.1 SPRINT Security Dongle 

The security dongle sets the SPRINT aiding options (S5 or S10 system). 
The SPRINT S5 and S10 aiding options are shown in Figure 6-11 and Figure 6-12. 

 

1. Refer to Figure 6-9. The dongle validity and date/time of expiry information is displayed 
within the SPRINT information bar.   

Figure 6-9 – Dongle Info Bar 

 

 

2. Refer to Figure 6-10. The SPRINT aiding options (S5 or S10) can be viewed by selecting 
Help > About > Dongle Info from the SPRINT Menu bar. 

Figure 6-10 – Dongle information 
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3. Refer to Figure 6-11 and Figure 6-12. SPRINT aiding options for S5 and S10 systems 
are displayed along with dongle validity, type of expiry and date/time of expiry. 

Figure 6-11 – SPRINT S5 Settings 

 
 

Figure 6-12 – SPRINT S10 Settings 
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6.3.2 Lodestar Connection 

To connect the Lodestar to the SPRINT system, follow the instructions below: 

1. If this is the first time the software has been connected to the Lodestar or the connection is 
not active, the connection window should automatically be displayed. If the connection 
window does not appear, open it by selecting Configure > Lodestar > Connections from the 
software menu. 

2. In the Connection to Lodestar screen, select the Ethernet/LCH tab and enter the IP 
Address and Port: 

 Refer to Figure 6-13. If the Lodestar is connected by means of a serial connection to 
the LCH, enter IP Address: 192.168.179.51 and Port 5001. 

Figure 6-13 – Serial Connection to Lodestar 

 
 

 Refer to Figure 6-14. If the Lodestar is connected directly by means of an Ethernet 
connection to the LCH, enter IP Address: 192.168.179.50 and Port 4000. 

Figure 6-14 – Ethernet Connection to Lodestar 

 
 

3. Refer to Figure 6-15. Click Connect. If this is the first time the system has been run and 
connected to the Lodestar it will then configure communications routing and ‘pipes’. It may 
take several minutes for this process to complete; a progress indicator will be displayed. 
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Figure 6-15 – Updating Port Configuration 

 
 

4. Once connected, the SPRINT software will check the settings of the Lodestar and may 
prompt the user to apply a stored configuration. 

 Refer to Figure 6-16. If this is the first time the system has been run, the user may be 
prompted to apply the Factory (Default) Configuration. 

Figure 6-16 – Apply Factory Configuration 

 
 

 Refer to Figure 6-17. If the system has been run before but the Lodestar settings are 
different than the last used (e.g. a different Lodestar is being used), the user may be 
prompted to re-apply the User Configuration. 

Figure 6-17 – Apply User Configuration 

 

5. Refer to Figure 6-18.If the Lodestar is not connected the software will prevent the user 
accessing any windows to retrieve or configure Lodestar settings. 

Figure 6-18 – No Lodestar Connection for Configuration 
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6. In addition, the system status LEDs at the bottom of the main application window will indicate 
that there is no Lodestar connection, as shown below in Figure 6-19: 

Figure 6-19 – Lodestar not Connected Status 

 
 

6.3.3 Lodestar Settings 

To configure the Lodestar settings, proceed as follows: 

1. Select Configure > Lodestar from the software menu. 

2. Refer to Figure 6-20. Enter a default Latitude value. After any manual change of the default 
latitude the Gyrocompass algorithm will be automatically reset. The Gyrocompass algorithm 
can be manually reset at any time by clicking the Gyro Compass Reset button. 

Figure 6-20 – Lodestar Settings 
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NOTE 

 Failure to update the default Latitude to match the current working area could result in 
poor Lodestar gyrocompass and inertial performance. After any change of default Latitude 
the Lodestar Gyro Compass algorithm is reset. During INS operations the Lodestar Latitude 
value will be automatically updated by position aiding messages (USBL). 

3. Set the Lodestar Power Management time period. The Lodestar will run on its internal 
battery for the selected time period (default period is 20 minutes) after the external power 
supply has been stopped. 

4. Enter the Lever Arms (From Vehicle CRP) offset values. After changing these values, the 
Gyrocompass/AHRS and INS algorithms will be automatically reset to use the new settings. 

5. Enter the Mounting Angles (From Vehicle Frame) offset values. After changing these 
values, the Gyrocompass/AHRS and INS algorithms will be automatically reset to use the 
new settings. 

6. The Lodestar can be manually shutdown at any time by pressing the Shutdown Lodestar 
button, after which the SPRINT software will also close. 

7. The Lodestar (firmware) can be manually reset at any time by pressing the Reset Lodestar 
button. 

8. Click OK to close and save all entered settings. 
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6.3.4 Lodestar Time Synchronisation 

To configure the Lodestar Time Synchronisation, proceed as follows: 

1. Refer to Figure 6-21. Select Configure > Time Synchronisation from the software menu: 

Figure 6-21 – Lodestar Time Synchronisation 

 
 

2. In the Time Synchronisation screen, select Type: ZDA Only (default) or GPZDA and 1PPS. 

3. Refer to Figure 6-22. Click Configure and enter the PC Port Serial IP Address 
192.168.179.51, Socket 5003 via the LCH. 

Figure 6-22 – Adding IP Address 

 
4. Click OK to return to the Time Synchronisation screen and enter the ZDA Latency value. 

NOTE 

 The Time Synchronisation can be reset at any time by selecting Reset Time Synch. 
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5. If GPZDA and 1PPS is selected then configure the 1PPS Input settings. The default Lodestar 
Input setting for 1PPS is Lodestar Port C2. 

6. Click OK to close and save all entered settings. 

6.3.5 USBL Aiding 

To configure the USBL Aiding, proceed as follows: 

1. Select Configure > INS > USBL Input from the software menu. 

Figure 6-23 – USBL Aiding 

 
2. Refer to Figure 6-23. Select a USBL Aiding Input Type: PSIMSSB (Default) or USBL GGA  

(Acoustic). Typical USBL aiding inputs are as follows: 

 Sonardyne Ranger/Fusion USBL or EIVA NaviPac: Acoustic GGA. 

 Sonardyne Marksman/Ranger 2 or Kongsberg HiPAP: PSIMSSB. 

3. In the PC/LCH Port enter the IP Address for the serial input via the LCH 
(192.168.179.51:5004) by clicking Configure (as shown in Figure 6-22). 

4. If required specify a Beacon ID filter, see Appendix E for details of the beacon ID field of the 
different USBL aiding messages. 
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5. Horizontal USBL quality: 

i) The default setting is for SPRINT to use the quality value provided by the USBL system 
in the aiding message, see Appendix E for details. In this case the Set Horizontal 
Manual Quality checkbox will be unchecked. 

ii) In some cases, it may be required to set a manual horizontal quality value: 

 If using Sonardyne Ranger, Fusion USBL or other USBL systems where no 
quality value is provided. 

 The quality value provided by the USBL system is overly optimistic. 

iii) To set the Horizontal Manual Quality, set the check box and enter a Horizontal RMS 
value. 

6. Vertical USBL quality: 

i) If USBL depth aiding is to be used by SPRINT, the configured Vertical RMS value will 
be used by the INS. The value should be set according to the method of depth 
measurement: 

 Acoustic 

 Sensor Measurement 

7. In the USBL Beacon Mounting (from Vehicle CRP) enter the Lever Arm offsets from the 
ROV CRP to the USBL beacon. After changing the lever arms the INS algorithm will be 
automatically reset to use the new settings. 

8. Click OK to close and save all entered settings. 

9. If Sonardyne Marksman or Ranger 2 is being used for USBL aiding, configuration instructions 
are provided in Section 7.2. 
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6.3.6 Depth Aiding 

To configure the Depth aiding, proceed as follows: 

1. Select Configure > INS > Depth Input from the software menu. 

Figure 6-24 – Depth Aiding 

 
 

2. Refer to Figure 6-24. From the Depth Type drop down menu, select the Type: DigiQuartz 
(kPa, PSI or Metres); NMEA DPT or Son Depth. 

3. Select a Depth Input by selecting either PC/LCH Port or Lodestar Port. 

4. If the sensor is connected via a serial connection, select the PC/LCH Port and enter the IP 
Address for the serial input via the LCH (192.168.179.51:5005) by clicking Configure (as 
shown in Figure 6-22). 

5. If the sensor is connected directly to the Lodestar, select Lodestar Port and the relevant 
connection point (C1, T1, T2). 
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6. Refer to Figure 6-25. Click Configure and enter the Lodestar Configuration settings. 

Figure 6-25 – Lodestar Configuration 

 

7. Click OK to save all entered settings and return to the Depth window. 

8. Enter the Surface Depth Offset value in metres if required. If the ROV is on deck and the 
ambient surface pressure is to be removed from raw pressure depth value, click Auto Set. 

9. Enter the Depth Sensor Mounting (from Vehicle CRP) Lever Arm offset from ROV CRP to 
Sensor. After changing the lever arms the INS algorithm will be automatically reset to use the 
new settings. 

10. Click OK to close and save all entered settings. 
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6.3.7 DVL Aiding 

To configure the DVL aiding, proceed as follows: 

1. Select Configure > INS > DVL Input from the software menu. 

Figure 6-26 – DVL Aiding 

 
 

2. Refer to Figure 6-26. Select the Lodestar DVL Connection port from the drop down menu, 
click Apply to set the port before continuing. 

3. Select Triggered by Lodestar checkbox if required. 

4. Select the Hex-ASCII DVL Data Output checkbox if the DVL will be outputting ASCII data; if 
left unchecked the Lodestar will expect binary data (default). 

NOTE 

 The DVL mounting angles, scale factor and latency can be calculated using the 
calibration routine explained in Appendix C. If the DVL input is being configured on deck 
prior to the calibration, it is recommended that the default mounting angles, scale factor and 
latency values are used. 

5. Enter the Scale Factor and Latency values from the DVL calibration. 

6. Enter the Lever Arm offsets from the ROV CRP to DVL; enter the Mounting Angles from the 
ROV frame to the DVL. After changing the mounting angles or lever arms the INS algorithm 
will be automatically reset to use the new settings. 
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7. Refer to Figure 6-27. If the DVL connected to Lodestar is a Teledyne RDI unit the SPRINT 
software can automatically program it for use with SPRINT. To configure the DVL click the 
Auto Configure button. The DVL configuration dialog will open.  

Figure 6-27 – DVL Auto Configuration 

 
 

NOTE 

 Make sure the Teledyne RDI DVL is connected to the Lodestar and powered before 
trying to configure it. 

8. DVL Mode: If the DVL cabling will allow the Lodestar to send a trigger to the selected DVL , 
select Triggered, otherwise select Free Running. 

9. Data Format: The data format output of the DVL will be set to Binary by default. If Hex-ASCII 
is required, select  Hex-ASCII. 

10. Select Data Stream: The data stream message output of the DVL will be set to PD4 by 
default. If PD5 is required, select PD5. 

11. Click the Configure button to configure the DVL; the software will display the progress of the 
configuration process. 

12. If the DVL is already configured, the Deploy button will command the DVL to start making 
measurements. 

13. When the DVL has been configured return to the DVL dialog. 

14. Click OK or Apply to save the settings. 
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6.3.8 Sound Velocity 

To configure the Sound Velocity, proceed as follow: 

1. Select Configure > INS > DVL Input from the software menu and click the Sound Velocity 
button. 

Figure 6-28 – Sound Velocity Configuration 

 
 

2. Refer to Figure 6-28. Select Sound Velocity Type. Available options include: 

 DVL Derived which is valid for most ocean conditions; in this method the sound velocity 
is automatically calculated using the salinity value and measurements from other aiding 
sensors such as DVL (Temperature) and Pressure/Depth (Pressure). 

 Various options for receiving sound velocity measurement messages from a sensor or 
other sources, such as a Valeport Mini-SVS. 

 Manual Sound Velocity. 

3. If Sound Velocity messages will be received from a sensor or other source specify and 
configure either: 

 The Lodestar port which will receive the Sound Velocity message (on the vehicle). 

 The LCH or PC port which will receive the Sound Velocity message (topside). 

4. If the Manual Sound Velocity type has been selected a value can be entered in the Manual 
Sound Velocity text box. 

5. Click OK to close and save all entered settings. 
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6.3.9 LBL 

To configure LBL aiding, proceed as follows: 

1. Select Configure > INS > LBL Input from the software menu. 

Figure 6-29 – LBL Aiding Configuration 

 
 

2. Refer to Figure 6-29. Lodestar Transceiver Connection: Select the Lodestar port that the 
LBL transceiver is physically connected to (usually T2) and configure the baud rate as 
required by clicking Configure (as shown in Figure 6-25). 

3. Fusion LBL Interface: Specify the PC port that will be used to provide LBL transceiver 
communications to the Fusion LBL software. 

4. Click OK to close and save all entered settings. 

5. Configure Fusion LBL for use with SPRINT by following the instructions provided in  
Section 7.1. 

NOTE 

 Depending on the SPRINT version, LBL aiding may not be available. 
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6.3.10 INS 

To configure the INS, proceed as follows: 

1. Refer to Figure 6-30. Select Configure > INS from the software menu. 

Figure 6-30 – INS Configuration 

 
2. Select the INS Aiding Inputs; USBL, Pressure Depth and DVL are selected by default. 

NOTE 

 The INS can be reset at any time by selecting Reset INS. 

3. Even without any external aiding the INS can be reset at a specific position by selecting 
Reset at position below and entering a WGS84 Latitude and Longitude then clicking the 
Reset INS button. 

4. Click OK to close and save all entered settings. 

6.3.11 Options 

To configure software options proceed as follows: 

1. Refer to Figure 6-31. Select Configure > Options from the software menu. 

2. Select the INS Position Chart Settings tab to configure preferences for the software INS 
chart display. 

Figure 6-31 – INS Position Chart Settings 

 
 

3. Refer to Figure 6-32. Select the External Position Chart Settings tab to configure 
preferences for the software external chart display. If using Windows 7, double click on either 
the USBL, INS or Transponder chart shapes to centre in the main chart. 
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Figure 6-32 – External Position Chart Settings 

 
 

4. Refer to Figure 6-33. Select the User Limits tab to configure navigation horizontal and depth 
quality limits. If the limits are enabled the software will alert the user if the limits are exceeded, 
see Section 9.1.7 for more details. 

Figure 6-33 – User Limits 

 
 

5. Refer to Figure 6-34. Select the Misc. Options tab to configure the position text type and 
history length of the time series plots. It is recommended to select the Automatically Start 
with Windows option. 

Figure 6-34 – Misc. Options 

 

6. Click OK to close and save all entered settings. 
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NOTE 

 The Show LBL beacons and range history option within the External Position Chart 
Settings tab can only be enabled when using Windows 7 PC. 

6.3.12 Logging 

To configure the Logging process, proceed as follows: 

1. Refer to Figure 6-35. Select Configure > Logging from the software menu. 

Figure 6-35 – Logging Configuration 

 
 

2. Default settings for logging are already defined but may be changed as required.  

3. Clicking the Restart Logging button will close the current log file and open a new one. 

6.3.13 Remote Output Points 

To configure the Remote Output Points, proceed as follows: 

1. Refer to Figure 6-36. Select Configure > Outputs > Remote Points from the software 
menu. 

Figure 6-36 – Remote Output Points Configuration 

 
 

2. The system can support navigation and attitude outputs with respect to two remote points on 
the vehicle.  

NOTE 

 By default all outputs will be with respect to the CRP of the vehicle. 
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3. Enter any lever arms for the remote points from the CRP to the remote point specified. 

4. Click OK to close and save all entered settings. 

6.3.14 Lodestar Output 

To configure outputs from the Lodestar ports, proceed as follows: 

1. Refer to Figure 6-37. Select Configure > Outputs > Lodestar Port Outputs from the 
software menu. Lodestar ports that are not currently in use (connected to the topside system 
or to an ROV sensor) will be available to configure as an output. 

Figure 6-37 – Lodestar Output Configuration 

 
2. Select the tab for the required port to configure.  

3. Select the message type, output rate and if a remote output point is to be used (the default 
output will be with respect to the vehicle CRP). For some outputs (such as a raw sensor feed) 
an output rate cannot be specified as this is defined by the sensor itself. 

4. Click Apply to configure the output.  

5. If further outputs are required, click Add and repeat the configuration steps outlined above. 

6. After configuration, click OK to close and save all entered settings. 
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6.3.15 PC Port Outputs 

The system supports two local output ports (primary and secondary). To configure outputs from the 
local PC or LCH ports, proceed as follows: 

1. Refer to Figure 6-38. Select Configure > Outputs > PCA CH Port Outputs from the 
software menu. 

Figure 6-38 – PC Output Configuration 

 
2. Select the tab for the required port to configure. 

3. Configure the PC/LCH Port; enter the IP Address for the serial input via the LCH by clicking 
Configure (as shown in Figure 6-22). 

4. Select the message type, output rate and if a remote output point is to be used (the default 
output will be with respect to the vehicle CRP). For some outputs (such as a raw sensor feed) 
an output rate cannot be specified as this is defined by the sensor itself. 

5. Click Apply to configure the output.  

6. If further outputs are required, click Add and repeat the configuration steps outlined above. 

7. After configuration, click OK to close and save all entered settings. 
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6.3.16 View Lever Arms 

To view a 3D representation of the configured sensor offsets, proceed as follows: 

1. Refer to Figure 6-39. Select View > Lever Arms from the software menu. 

Figure 6-39 – View Lever Arms 

 
 

2. The resulting window will display side and top views of all offsets. Note that scale is 
dependent on the level of zoom applied. Use this view to check that all offsets are correct and 
no errors are present. 
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6.3.17 Main Software Window 

To configure outputs from the local PC or LCH ports, proceed as follows: 

1. Refer to Figure 6-40. Pressing the ‘Zoom All’ button will auto zoom the chart on the main 
software window to keep all chart shapes visible at all times. 

Figure 6-40 – Zoom All 

 
 

2. Refer to Figure 6-41. Pressing the ‘Zoom In’ button will zoom in the chart display. 

Figure 6-41 – Zoom In 

 
 

3. Refer to Figure 6-42. Pressing the ‘Zoom Out’ button will zoom out the chart display. 

Figure 6-42 – Zoom Out 

 
 

4. Refer to Figure 6-43. Pressing the ‘Erase History’ button will erase any position history trails 
on the chart display. 

Figure 6-43 – Erase History 

 
 

5. Refer to Figure 6-44. Pressing the ‘ZUPT’ button will enable or disable ZUPT (Zero Velocity) 
aiding, see Section 8.3 for more details. 

Figure 6-44 – ZUPT 

 
 

6. Refer to Figure 6-45. Pressing the ‘INS reset’ button will reset the INS. 

Figure 6-45 – INS Reset 

 
 

7. Refer to Figure 6-46. All aiding inputs can be enabled/disabled for INS use or configured by 
right clicking on the appropriate aiding input LED and selecting the required option. 
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Figure 6-46 – Enable / Configure Aiding Input 

 
 

6.3.18 Time Series Plots 

Navigation and quality data displayed on the user interface can be graphically displayed on a chart 
as Time Series Plots. Examples of plotted charts are shown in Figure 6-47 and Figure 6-48. 

1. Refer to Figure 6-47. This time series plot shows INS Velocities North/East/Down. 

Figure 6-47 – Time Series Plot 

 

2. Refer to Figure 6-48. This time series plot shows INS Depth, External position and INS 
horizontal position qualities. 

Figure 6-48 – Time Series Plot 
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The following steps describe how to display data as single and multiple plots. 

1. Refer to Figure 6-49. To display navigation measurements (apart from Lat and Long), quality 
and INS statistics, right-click a value on the navigation text panel and select Show on New 
Chart Area. 

Figure 6-49 – Show on New Chart Area 

 

2. Refer to Figure 6-50. To display additional plots on the same chart, right-click a value on the 
navigation text panel and select Show on Chart Area. 

Figure 6-50 – Show on Chart Area 

 

3. Refer to Figure 6-51. To remove data from a chart, right-click the value on the navigation text 
panel and select Remove Time Series Plot. 

Figure 6-51 – Remove Time Series Plot 

 

 



 

User Manual for SPRINT UM-8253-000
Issue A Rev 3

 

 

Section 6 
15 November 2013 61 

 

NOTE 

 There is a limitation of three sensor inputs per plot and a maximum of four Time Series 
Plots displayed simultaneously, plus the LBL Aiding Plot. 

6.3.19 Exporting Configuration and Log Files 

To export system configuration and log files, proceed as follows: 

1. Refer to Figure 6-52. Select File > Export Configuration from the software menu. 

Figure 6-52 – Export configuration and log files 

 
 

2. Specify either the Last number of hours to export or a date/time range. 

3. Specify a destination directory for the exported file. 

4. Click the Export button to create the export file. 
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6.4 Check List 
Use the summary list below to assist in the system configuration, prior to operation: 

 Action Manual Section Checked

1 Configure the LCH 6.2  

2 Check Dongle is Valid 6.3.1  

3 Configure the Lodestar Connection 6.3.2  

4 Configure Lodestar 6.3.3  

5 Configure Time Synchronisation 6.3.4  

6 Configure USBL Aiding 6.3.5  

7 Configure Depth Aiding 6.3.6  

8 Configure DVL Aiding 6.3.7  

9 Configure Sound Velocity 6.3.8  

10 Configure LBL Aiding 6.3.9  

11 Configure INS Aiding 6.3.10  

12 Configure Options 6.3.11  

13 Configure Logging 6.3.12  

14 Configure Outputs 
6.3.13, 6.3.14 and 
6.3.15 

 

Sign: 
…………………………………………………….. 

Date: 
……………………………………………….. 

 

NOTE 

 See Appendix H for a full step-by-step installation and setup checklist that can be 
printed and used as a hard copy reference. 
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SECTION 7 – CONFIGURING ACOUSTIC AIDING 

7. Configuring Acoustic Aiding from Sonardyne Systems 

7.1 Fusion LBL Aiding 
To interface Fusion LBL to SPRINT for aiding, follow the steps below (for further information on 
operation of Fusion, refer to the Fusion Manual OM-8025-000-01). The instructions assume the 
following connections have already been configured: 

i) A Lodestar is running and connected to the SPRINT software. 

ii) LBL Transceiver is physically connected to Lodestar T1 or T2 port and is powered. 

iii) The Fusion LBL interface ports have been configured in SPRINT (see Section 6.3.9): 

 Transceiver PC Port 

 INS PC Port 

1. Open Fusion LBL and add an LBL Transceiver from the acoustic instruments group in the job 
tree. 

Figure 7-1 – Adding an LBL Transceiver 

 
 

2. After adding an LBL transceiver, specify the PC COM port configured in SPRINT. 
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3. Refer to Figure 7-2. On the LBL Transceiver properties page, click the Advanced button to 
open the advanced transceiver options page. 

Figure 7-2 – LBL Transceiver Properties 

 
 

4. Refer to Figure 7-3. In the Comms reset option select None, then click Close. 

Figure 7-3 – LBL Transceiver Advanced Ranging Options 

 
                                      

NOTE 

 In later versions of Fusion, the baud rate of the transceiver may be automatically 
changed when it is added. In this case the baud rate of the transceiver must be manually 
changed in the SPRINT software to match Fusion and the new baud rate of the Transceiver. 
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5. Refer to Figure 7-4. On the LBL Transceiver Properties Summary/Comms tab, click Test to 
check connection and communications to the Transceiver. Once connection is established 
the Fusion software will confirm that the instrument is working.  

Figure 7-4 – Check connection and communication 

 
 

6. Click OK to close the Transceiver LBL Tcvr Properties page. 

7. Refer to Figure 7-5. Add a Lodestar from the non-acoustic INS instruments group in the job 
tree: 

Figure 7-5 – Adding a Lodestar 
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8. Refer to Figure 7-6. After adding the Lodestar, specify the PC COM port that has been 
configured in SPRINT. 

Figure 7-6 – Non-Acoustic Instrument INS Properties 

 
 

9. The PC port may be a physical COM port of a virtual serial port pair if Fusion is running on 
the same PC as SPRINT.  

10. Select the transceiver connected to the Lodestar from the Transceiver drop-down list. 

11. Refer to Figure 7-7. To check the Lodestar’s output to Fusion, select either the Heading, 
VRU, Depth or Position tabs. The data displayed will be sourced from the Lodestar.  

12. Click OK to close and save enetered settings. 

Figure 7-7 – Checking Lodestar Heading Output to Fusion 
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13. Refer to Figure 7-8. After adding the INS (Lodestar) and Transceiver, they should be listed in 
the Fusion LBL Job Tree. 

Figure 7-8 – Fusion LBL Job Tree 

 
 

14. The instruments must now be added to an ROV. Select the ROV from the job tree, then open 
the Instruments tab on the ROV properties page. 

15. Refer to Figure 7-9. Add the INS (Lodestar) and the appropriate Transducer by clicking the 
Add button and selecting from the list of available instruments.  

Figure 7-9 – Adding Instruments to the ROV 
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16. Refer to Figure 7-10. Adding each instrument, click the Offset Configure to enter the 
instrument offsets: 

Figure 7-10 – ROV Instruments Configure 

 
 

17. Enter the offsets for both instruments with respect to the vehicle CRP. 

NOTE 

 The convention for the instruments may differ from the SPRINT system. These values 
only require entry at this point as they will automatically be sent to the SPRINT system and 
the Lodestar. 

Figure 7-11 – Configure ROV Offsets 

 
 

18. Click OK to close and save all entered settings. 
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19. Refer to Figure 7-12. In the Properties for ROV window, select the Positioning tab: 

Figure 7-12 – ROV Positioning Properties 

 
 

20. To use the depth output from the Lodestar select Measured as the Depth measurement 
source. 

21. To use the heading output from the Lodestar select Measured as the Heading measurement 
source. 

22. To use the INS position output from the Lodestar select INS as the Position measurement 
source. Alternatively, for LBL acoustic solution, select Acoustic as the Position 
measurement source. 

23. Refer to Figure 7-13. To specify the reference beacons for this ROV, click Select 
References: 

Figure 7-13 – ROV Positioning Properties Select References 

 
 



 

User Manual for SPRINT UM-8253-000
Issue A Rev 3

 

 

Section 7 
15 November 2013 70 

NOTE 

 Not all reference beacons specified need to be used for INS LBL aiding but must be 
specified if the SPRINT system is to record the observations for other purposes, such as 
post processing in Janus. 

24. Refer to Figure 7-14. After adding the references, click OK to close the Select References 
page. 

Figure 7-14 – Select ROV References 

 
 

25. Click OK to close the ROV properties page. By default, all reference beacons added as 
references will be used for INS aiding.  

26. Refer to Figure 7-15. To disable a beacon for INS aiding but to still record LBL data in 
SPRINT (for use offline) open the properties page for the Compatt and deselect Use in INS. 

Figure 7-15 – Compatt Properties 
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27. The ROV can now be tracked using INS with LBL aiding. Click the green Go button to start 
the tracking wizard. 

28. Refer to Figure 7-16. Select the correct ROV for tracking, then click Tracking On. 

Figure 7-16 – Tracking Wizard Vehicle Selection 

 
 

29. Click Next to proceed. 

30. Refer to Figure 7-17. If prompted, the transceiver may need to be set by clicking either the 
Quick Set or Full Set button. 

Figure 7-17 – Tracking Wizard Initialise Transceivers 

 
 

31. Click Next to proceed. 
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32. Refer to Figure 7-18. If prompted, the beacons may need to be set using either the Quick 
Set or Full Set button: 

Figure 7-18 – Tracking Wizard Initialise Beacons 

 
 

33. Click Next to proceed. 

34. Refer to Figure 7-19. Click Finish to start tracking and configure any specific Fusion log files: 

Figure 7-19 – Tracking Wizard Logging and Finish 
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7.2 Marksman & Ranger 2 USBL Aiding 
To interface Marksman or Ranger 2 USBL to SPRINT for aiding, follow the steps below. The 
instructions assume the USBL system has already been configured as follows: 

i) Calibrated and compensated for vessel movement with a high grade MRU/AHRS. 

ii) UC time synchronised. 

iii) Is using GPS (WGS84) to provide absolute positions. 

iv) Using correct sound velocity. 

v) Is configured to track the ROV USBL beacon as a mobile beacon. 

1. Refer to Figure 7-20. Add a new SSB telegram output: 

Figure 7-20 – Adding a New Telegram 

 
 

2. In the Report Properties, select 9600 as the baud rate and select an appropriate port to 
output the message to SPRINT. 

3. Refer to Figure 7-21. Specify the following telegram options. 

 Frame of Reference: select World 

 Orientation: select Lat/Long 

 Source: select Raw 

Figure 7-21 – Telegram Options 
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SECTION 8 – OPERATION 

8. Operation 

8.1 INS 

8.1.1 Initialisation 

Refer to Figure 8-1 for a typical descent and INS initialisation sequence. The INS will require the 
following to initialise: 

1. The AHRS algorithm should be settled. This will take 10 minutes from Lodestar start-up in the 
default SPRINT configuration. The ROV can be moving. On the main software window the 
AHRS status LED will be green when the AHRS is settled, see Section 9.1.2 System and 
Aiding Status. 

2. The Lodestar should be time synchronised. On the main software window the Time Synch 
status LED will be green when the Lodestar is Time Synchronised, see Section 9.1.2 
System and Aiding Status. 

3. A starting position for the INS algorithm. In normal operation this will be provided by the first 
accepted USBL position for the vehicle during descent. 

Figure 8-1 – Descent and INS Initialisation Sequence 

 
 



 

User Manual for SPRINT UM-8253-000
Issue A Rev 3

 

 

Section 8 
15 November 2013 75 

8.2 Fusion LBL Aiding 

8.2.1 Transition from USBL to LBL aided INS 

To transition from USBL aided INS to LBL follow the steps below: 

1. Make sure SPRINT has good USBL and DVL aiding (e.g. bottom lock). The ROV should 
continue with some dynamics during the following steps. 

2. Check Fusion is tracking and that ranges are being received in the Fusion measurements 
panel. 

3. Refer to Figure 8-2. Click the DVL and LBL Aiding checkboxes. 

Figure 8-2 – INS Aiding with LBL Aiding 

 
 

4. LBL aiding can then be monitored in operation as described in Section 9.1.5. 
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8.3 Zero Velocity (ZUPT) Aiding 

8.3.1 Features and Operational Guidelines 

Zero velocity aiding feeds ‘zero’ velocities in to the INS (with an amount of error) to help the INS 
estimate sensor bias errors when a vehicle is not moving. It can be used to: 

 Stop INS position drift if DVL, USBL or LBL aiding is lost 

 Provide better static fix results if aiding data is poor (e.g. USBL) 

Rules for Zero Velocity (ZUPT) Aiding: 

NOTE 

 If Zero Velocity (ZUPT) aiding is used when the vehicle is moving the INS integrity and 
performance could be affected 

 Must ONLY be used when the ROV is truly static 

 Must NEVER be used when the ROV is moving 

 Switching between USBL and LBL aiding must NOT be carried out when the INS is 
ZUPT aided as it will not be allowed to move between the two positioning sources. 

8.3.2 Enabling Zero Velocity (ZUPT) aiding 

Zero Velocity Aiding can be enabled by clicking the ZUPT button on the main SPRINT window, see 
Figure 8-3. It can disabled by pressing the ZUPT button again. When active the INS status on the 
navigation chart will display Navigating (ZERO VELOCITY). 

Figure 8-3 – Enabling ‘ZUPT’ Aiding 

 
 

8.3.3 Static Fixes with Zero Velocity (ZUPT) Aiding  

Follow the steps below if Zero Velocity Aiding (ZUPT) is to be used while taking a static fix. 

1. SPRINT should be ‘healthy’ with green LEDs before taking a static ZUPT fix. 

2. Manoeuvre the vehicle in to position for the static fix. 

3. Once the vehicle is static enable ZUPT mode. 

4. Record the static fix using 3rd party software. 

5. Turn off ZUPT mode. 

6. The vehicle can now move away from the static fix position. 

NOTE 

 ZUPT aiding may not be available depending on the SPRINT version 
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Pre-Dive Checklist 
Use the list below to assist in making sure the SPRINT system is ready before a dive. 

 Action Checked 

1 Check the Lodestar is powered.  

2 
Check all aiding sensors (Depth, DVL, Sound Velocity, and LBL 
Transceiver) are powered. 

 

3 Check the default Latitude in the SPRINT software.  

4 
Check the Lodestar, AHRS, Logging and Time Synch status LED’s are 
green (OK). 

 

5 
Check the Depth status LED is blue (not used). A red (critical) status could 
indicate there is no data being received. 

 

6 
If a DVL is being used, check the DVL status LED is blue (not used). A red 
(critical) status could indicate there is no data being received. 

 

7 
If an SV feed is being used, check the SV status LED is blue (not used). A 
red (critical) status could indicate there is no data being received. 

 

8 

If connected to an LBL transceiver, open the Fusion software and check 
the Transceiver connection by performing a ‘Get’ or ‘Test’ on the 
transceiver instrument page. 

 

9 
Check or set the (surface) pressure offset on the depth aiding page of the 
SPRINT software. 

 

Sign: 
…………………………………………………….. 

Date: 
……………………………………………….. 
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SECTION 9 – MAINTENANCE & MONITORING 

9. Maintenance & Monitoring 

9.1 Monitoring the System 

9.1.1 Main Application Window 

The main software window, with USBL, DVL and Depth aiding active, with key features highlighted 
is shown below in Figure 9-1. 

Figure 9-1 – Main Application Window 

 
 

9.1.2 System and Aiding Status 

Refer to Figure 9-2. All the major system components and aiding inputs can be monitored via ‘traffic 
lights’ at the bottom of the main software window: 

Figure 9-2 – System and Aiding Status 

 
 

The following system components are always monitored: 

 Lodestar (Hardware) 

 AHRS (Attitude Heading Reference System) 

 INS (Inertial Navigation System) 

 Time (Synchronisation) 

 (Local PC) Logging 
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Aiding inputs are monitored if they are specified for INS aiding in the INS Settings configuration. 
The colour of the monitoring ‘traffic lights’ is explained below: 

Table 9-1 – System and Aiding Status ‘Traffic Light’ Colours 

Status ‘Traffic Light’ 
Colour 

Example States 

Critical Red 

Communications Failure to Component 
Hardware Issue 
Component not Initialised or running correctly 
Timeout for Critical Instrument (typically 30 second limit) 

Warning Orange / Amber 
Aiding Sensor Data Rejected 
AHRS Algorithm Settling 

OK Green 
Data Received within Time Limit 
Data Accepted and Used 

Not Used 
or 
Disabled 

Blue 
Aiding data is received but as the INS is not initialised it is 
not yet being used. 

 
A text description for each component status is provided in the status list and can also be seen by 
placing a mouse over the appropriate LED, as shown in Figure 9-3 (with the example of the INS 
being unable to initialise as it is not receiving position). If there is an issue, the status text will 
provide guidance to resolve it. 

Figure 9-3 – Component Status Popup 
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9.1.3 Navigation Text Panel 

Real time navigation data is displayed in the navigation text panel. All positions can either be 
displayed in WGS 84 decimal degrees or UTM Eastings and Northings. Various quality metrics are 
also displayed in the panel for both the INS and the Lodestar time synchronisation status. 

Figure 9-4 – Navigation Text Panel 

 
 

NOTE 

 The displayed USBL beacon position and external depth are with respect to the vehicle 
CRP to allow for direct comparison with the INS position, which is also with respect to the 
vehicle CRP. 
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9.1.4 INS Statistics 

Refer to Figure 9-5. To view detailed INS performance statistics, from the menu select View > INS 
Statistics: 

Figure 9-5 – INS Statistics 

 
 

NOTE 

 If the INS Statistics display is closed while in use as Time Series Plots, the plots will be 
deleted. 
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9.1.5 INS with Fusion LBL Aiding 

When LBL is selected and used as an aiding source in SPRINT, there are some features that 
should be noted in the SPRINT software. See the LBL aiding example in Figure 9-6. When LBL 
aiding is active the USBL position is still displayed for comparison but is not used for aiding. 
Additionally the INS error ellipse may take a distinctive shape that is representative of the geometry 
of the vehicle with respect to the reference beacons used for aiding. 

 

Figure 9-6 – SPRINT with Fusion LBL Aiding 

 
 
If any LBL ranges are rejected, the LBL aiding ‘traffic light’ will change to amber/orange and the 
beacon address and reason for rejection will be displayed. Examples showing reasons of LBL 
rejection are shown in Figure 9-7. 

Figure 9-7 – LBL Aiding Rejection 
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Select View > LBL Aiding from the software menu to see additional LBL aiding information as 
shown in Figure 9-8. 

Figure 9-8 – LBL Aiding Window 

 
 
The LBL aiding window will display aiding information for all LBL beacons which are currently being 
tracked while SPRINT is LBL aided. 

The upper graph displays travel time for all tracked beacons while the lower graph displays the LBL 
aiding range residuals. The residuals displayed are the differences between the INS estimated and 
the actual received LBL ranges and are therefore an extremely useful indication of LBL aiding 
health. The residuals should typically be low (<10cm) and centred around zero. 

To edit the LBL aiding chart contents: 

1. Press the minus sign −. on the keyboard to hide the beacon text.  

2. Right-click on the charts to enable options to: 

 Maximise or hide one of the charts 

 Show or hide data from individual beacons 

 Copy and save the charts 

3. Dragging the mouse over a section of the chart will zoom into the area selected. 

It is recommended that during critical INS positioning with LBL aiding, the LBL aiding window is 
kept open to monitor the aiding, as shown below in Figure 9-9. 
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Figure 9-9 – Monitoring LBL Aiding 

 
 
If the residuals are not centred around zero, this would indicate that there is a systematic error with 
LBL aiding, such as: 

 Sound velocity 

 Beacon to INS relative depth 

If LBL aiding observations are rejected, it will be indicated by a red cross on the residuals display, 
as shown in Figure 9-10. 

Figure 9-10 – LBL Aiding Rejection in Residuals Graph 
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9.1.6 Communications Monitor 

From any of the dialogs in the SPRINT software that allow the configuration of input or output 
communication, a comms monitoring function is provided. When the Comms button is clicked, a 
new window is displayed showing the received or sent data on the configured port – see Figure 
9-11. The actual message contents are provided in the Message column. 

Figure 9-11 – Communications Monitor 

 
 

The data received on the port is displayed green and the data sent on the port displayed blue as 
shown in Figure 9-11. The communications can be saved to a file by selecting a location and 
clicking the To File button. The communications can be filtered by entering Filter text. Any 
communication containing the filter text is displayed red as shown in Figure 9-12. 

Figure 9-12 – Communications Monitor Filter 

 
 

The communications stream can be paused by pressing the Pause button. 
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9.1.7 Navigation Quality Limits 

Navigation quality limits can be enabled and configured in the SPRINT software (see Section 
6.3.11). If enabled, the horizontal navigational quality limit will be displayed on the chart as a red 
circle (NB: INS horizontal quality is displayed as a yellow circle or ellipse). If either the vertical or 
horizontal quality limits are exceeded, the software will alert the user as shown in Figure 9-13: 

 The ‘Compass Ring’ on the navigation chart will flash red. 

 The INS status on the navigation chart will read ‘Quality Exceeds Limit’. 

 The relevant quality value in the navigation text panel will flash red. 

Figure 9-13 – Navigation Quality Limits Exceeded 

 
 

9.2 Maintaining the System 

9.2.1 Logging 

The system is configured to log all sensor data and internal state messages to allow for offline 
analysis, post processing and QC of real time SPRINT navigation. 

Data is logged automatically onto a local PC directory as configured previously. An automatic 
background process will make sure that the Navigation PC hard drive does not become full by 
deleting the logs in date order. 

The same data is also logged internally within the Lodestar on an 8GB SD card. The SD card data 
can be retrieved using the Lodestar Configuration software – see Lodestar Manual 8084-107 for 
instructions. 

9.2.2 Lodestar Firmware 

The Lodestar firmware can be upgraded using a direct serial connection (not via the LCH), see 
Lodestar Manual 8084-107 for instructions. 
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9.2.3 SPRINT Dongle Update 

The SPRINT dongle can be updated using the following procedure: 

1. Refer to Figure 9-14 and Figure 9-15. Select All Programs > Sonardyne > SPRINT > 
Security Tool from the Windows Start menu.  

2. Select Request Update > email reference code to support@sonardyne.com with the 
dongle request update. 

3. To activate the dongle update: Apply Update > select the .DUP (Dongle Update Packet) file 
received from Sonardyne Support. 

Figure 9-14 – SPRINT S5 Settings 

  

mailto:support@sonardyne.com�


 

User Manual for SPRINT UM-8253-000
Issue A Rev 3

 

 

Section 9 
15 November 2013 88 

Figure 9-15 – SPRINT S10 Settings 
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SECTION 10 – FUNCTIONAL TEST 

10. Testing 

It is strongly recommended the SPRINT system kit is assembled, tested and operated prior to 
installation on the subsea vehicle. A full set of Lodestar test cables is supplied with each SPRINT 
kit for that purpose.  

NOTE 

 The Lodestar Communications Hub and associated power cable can be used to provide 
48v power to the Lodestar during this test.  

The functional test will check that: 

1. A connection can be made between the Lodestar and Lodestar Communications Hub prior to 
it being routed through any interfaces between the subsea vehicle and the vessel. 

2. The Lodestar has the correct firmware and is enabled for use with SPRINT. 

3. Basic inertial navigation can be initialised. 

4. To undertake the test follow the operational steps listed in Section 6 prior to vehicle 
installation. 
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SECTION 11 – DVL CALIBRATION PROCEDURE 

11. Calibration 

An accurate calibration will typically require ~15-20 minutes of manoeuvring at the seabed. A quick 
calibration can be done in just a few minutes. Follow the instructions below to undertake a DVL 
calibration. 

Prior to the start of the calibration, make sure the following conditions apply: 

 The subsea vehicle must be within DVL range of the seabed with good bottom lock. 

 The subsea vehicle is being tracked with USBL and SPRINT is receiving USBL aiding. 

 The Pressure Depth input is active and SPRINT is receiving Pressure Depth aiding. 

 The correct sound velocity is being used by SPRINT. 

1. It is recommended to start a new log file with a suffix that will be clearly identifiable as DVL 
calibration data.  

2. Refer to Figure 11-1. Open the Logging dialog and enter the required log file suffix (e.g. 
DVLCalibration). 

Figure 11-1 – DVL Calibration Logging Configuration 

 
 

3. Click OK to close and save all entered settings 

4. The subsea vehicle can now undertake some specific manoeuvres. A suggested and efficient 
approach would be to travel along an approximate linear path whilst performing: 

 Accelerations along various axes including up/down. 

 Heading changes +/- 90°, i.e. sideways movement maintained for a few minutes. 

 Random high dynamic manoeuvres 

5. A total position change of ~500 metres is sufficient. For deep water, make the 
trajectory/duration longer for optimum performance. 

Figure 11-2 – DVL Calibration ROV Manoeuvres 
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6. When the calibration manoeuvres have been completed the subsea vehicle can continue with 
other operations. 

7. Open the Logging dialog and enter a log file suffix to indicate the log files no longer contain 
any DVL calibration data, the default log file suffix is LS. 

8. Create a working folder on the hard drive for the DVL calibration log files; e.g. My 
Documents\DVLCal. Create a subfolder in the working folder called LogFiles. 

NOTE 

 SPRINT binary log files have a .BIN extension 

9. Copy the relevant log files from the SPRINT logging location into the LogFiles folder; e.g. ‘My 
Documents\DVLCal\LogFiles’. SPRINT. 

NOTE 

 It is important to only copy the log files covering the time period of the DVL calibration 
manoeuvres as time taken to process the log files will increase with the amount of data 
used. 

10. Run the DVL Calibration tool by double-clicking the icon on the desktop (it may be necessary 
to wait up to 10 seconds for the application to run): 

11. The DVL calibration application will open on the AINS tab.  

12. Refer to Figure 11-3. Click the Choose job/root directory button and select the parent 
working folder, e.g. ‘My Documents\DVLCal’, and click OK. 
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Figure 11-3 – DVL Calibration Folder Selection 
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13. Refer to Figure 11-4. Select the Log file/Import data tab. 

Figure 11-4 – DVL Calibration Import Data 

 
 

14. Refer to Figure 11-5. Click Import data to import the data from the LogFiles, this may take 
several minutes. When the import is completed a list of imported data is displayed: 

Figure 11-5 – DVL Calibration Import Data 
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15. Refer to Figure 11-6. Select the DVL Calibration tab. 

Figure 11-6 – DVL Calibration Calibrate DVL 

 
 

16. The initial (default) values will be displayed. They do not need to be modified.  

17. Refer to Figure 11-7. Click the Calibrate DVL button. A progress indicator will show the 
processing status. 

Figure 11-7 – DVL Calibration Calibrate Progress 

 
 

18. Refer to Figure 11-8. When completed, two figures will be displayed. Figure 1: DVL 
Calibration displays the DVL velocity residuals for all axes before and after calibration. 

Figure 11-8 – DVL Calibration All Axes Residual Results 
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19. Refer to Figure 11-9. Figure 2 DVL Calibration displays the DVL velocity residuals for each 
axes before and after calibration. 

Figure 11-9 – DVL Calibration X, Y and Z Axes Residual Results 

 
 

20. Refer to Figure 11-10. On the DVL Calibration tab the estimated calibration values are 
displayed. 

Figure 11-10 – DVL Calibration Computed Results 

 
 

21. It is recommended a (PDF) copy of the DVL calibration report is saved by pressing the Save 
calibration report button and specifying an appropriate location.  
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22. Refer to Figure 11-11. Open the report to retrieve the results (they are also available directly 
from the DVL Calibration tab): 

Figure 11-11 – DVL Calibration Results Report 

 
 

23. Refer to Figure 11-12. In the SPRINT software, navigate to the DVL dialog (Configure > INS 
> DVL Input).  

24. Enter the calculated values in the dialog and click Apply or OK to save the changes: 

Figure 11-12 – DVL Entering Results in SPRINT 
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SECTION 12 – FAULT DIAGNOSIS 

12. Introduction 

The following sections suggest possible causes and/or solutions for problems that may be 
experienced for each system component. If, after checking the causes and solutions listed below 
the problem is still occurring please contact Sonardyne Support. You may be requested to provide 
a system configuration export as described in Section 6.3.19. 

12.1 Lodestar Connection 
When connecting the Lodestar, carry out the following: 

1. ALWAYS configure and check Lodestar connection prior to mounting on subsea vehicle. 

2. Make sure the Lodestar is fully charged (2-3 hours) prior to vehicle connection tests to 
eliminate any communication failures due to intermittent connections and power loss. 

3. Once the Lodestar is mounted on the vehicle, connect a laptop using test cables to verify 
Lodestar operation and sensor communications. 

4. Ethernet – check vehicle supports 100 megabit. 

5. Serial – check 232 485 cable select for console port connection issues. 

12.2 Attitude Heading Reference System (AHRS) 
When using the AHRS, make sure: 

1. The default Latitude is set. 

2. There is a constant bias noted. If so, check Lodestar mounting angles, lever arms and remote 
output points if configured. 

12.3 Inertial Navigation System (INS) 
When using the INS, make sure: 

1. Generally, INS will always reject for a valid reason. Rejection indicates issues for 
investigation on the aiding sensor. 

2. The most common reason for rejection of time stamped data (GPS / USBL) is an incorrectly 
configured time synchronisation. 

3. If bad aiding data is accepted as good then INS may report Bias, Accelerometer or Heading 
warnings. 

4. Following other troubleshooting steps first (INS is last port of call for issues/errors). 
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12.4 Time Synchronisation 
When using the Time Synchronisation process, make sure: 

1. If ZDA only is used, latency MUST be set. 

2. The ideal method is ZDA and 1PPS. 

3. Make sure any time stamped aiding (GPS/USBL) is also UTC time synched; check in comms 
viewer. 

4. If Lodestar is synchronised to difference time base than GPS/USBL the behaviour to notice is: 

 Lodestar accepts position data while static 

 Lodestar rejects position data as soon as it moves 

NOTE  

 Rejection reason might be ‘outside INS estimate’ rather than indicating a time synch 
issue, an INS cannot tell the difference. 

12.5 Aiding Inputs (All) 
When using Aiding Inputs, make sure to: 

1. Check input using: 

 Comms Monitor 

 Lodestar Port Traffic 

2. Check lever arms and mounting angles. 

12.6 USBL Aiding 
When using USBL Aiding: 

1. Make sure the USBL system is UTC time synched. 

2. Check UTC time stamp in telegram is correct. 

3. Make sure the Radians Lat/Long are selected for PSIMSSB message. 

4. Check that measured rather than filtered is selected (raw position is required). 

5. Make sure beacon ID is correct. 

6. Check USBL setup: 

 Lever arms and angular corrections (calibration) 

 Sound velocity 
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12.7 Depth Aiding 
When using Depth Aiding make sure: 

1. The correct units are selected. 

2. To check surface correction. 

12.8 Doppler Velocity Log (DVL) Aiding 
When using a Doppler Velocity Log Aiding system, make sure: 

1. The DVL is configured correctly. 

2. The sound velocity is correct. 

3. The latency and scale factor are configured correctly. 

12.9 LBL Aiding 
When using LBL Aiding: 

1. Is Fusion sound velocity correct? 

2. Is ROV to Beacon(s) relative depths correct?: 

 Tide 

 Absolute->Corrected 

3. Has INS had time to move between USBL and LBL? 

4. How does this beacon fit into array? 

5. Can the acoustic LBL position be used for comparison? 

6. Are the minimum/maximum range settings correct? 
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SECTION 13 – REMOVAL 

13. Introduction 

It is recommended that any packaging supplied with the SPRINT system is retained for future use. 

13.1 Dismantling 
If the system is to be returned to Sonardyne International, it must be dismantled as follows: 

WARNINGS 

 Heavy Equipment. The 1000 metres rated Lodestar weighs 14 kg. Manual Handling 
Equipment (MHE) must be used to move the Lodestar. If MHE is not available, then a manual 
handling assessment must be carried out prior to carrying out manual lifting / handling. 
Personal Protective Equipment such as protective footwear and gloves must be worn when 
lifting this equipment. 

 Heavy Equipment. The 3000 metres rated Lodestar weighs 22 kg. Manual Handling 
Equipment (MHE) must be used to move the Lodestar. If MHE is not available, then a manual 
handling assessment must be carried out prior to carrying out manual lifting / handling. 
Personal Protective Equipment such as protective footwear and gloves must be worn when 
lifting this equipment. 

 Heavy Equipment. The 5000 metres rated Lodestar weighs 39 kg. Manual Handling 
Equipment (MHE) must be used to move the Lodestar. If MHE is not available, then a manual 
handling assessment must be carried out prior to carrying out manual lifting / handling. 
Personal Protective Equipment such as protective footwear and gloves must be worn when 
lifting this equipment. 

1. Make sure the SPRINT software is stopped and closed. 

2. Make sure the power to the LCH is switched OFF. 

3. Make sure the power to the NAV PC is switched OFF. 

4. Rinse all subsea equipment with clean fresh water. Dry with lint free cloth. 

5. Disconnect all connections at the rear of the LCH. 

6. Disconnect all connections at the rear of the NAV PC. 

7. Disconnect all connections to the top of the Lodestar. 

8. Check all the equipment for signs of damage or corrosion. 

9. Make sure all equipment is clean and dry before inserting into the packing cases. 

10. Any problems encountered then please contact your nearest Sonardyne office. 
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SECTION 14 – SPARES 

14. Introduction 

There are no spares supplied with this system.  

14.1 Component Identification Table 
Refer to the list below when contacting Sonardyne International or your local office to identify any 
required component. 

Table 14-1 – Component Identification Table 

Stock Code Description Quantity 

620-0080 NAV Computer CORE 2 DUO - 8026-000-05-A6 1 

610-2362 OEM WIN XP PRO for embedded 1 

272-0345 Cable Mains Plug to straight  2 

272-0352 Cable Euro Plug to straight  2 

272-036C Cable USA Plug to straight IEC 2 

222-6004 SCR SL PAN HTS Chemi BLK M6X16 8 

205-0832 Schroff 21100-015 F/Panel plastic washer 8 

790-0931 Fusion packing box cardboard 2 

610-2393 OEM Norton Ghost 2005 V9 1 

820-6592 Earth Strap Eyelet Type - 8020-075-A1 2 

280-4001 Cable CAT.5e UTP patch 5M - RoHS 1 

272-0793 Video DVI-DVI Interface Cable - RoHS 1 

280-4714 Serial Data Cable 9 pin SUBD M/F 5M 8 

610-0048 OEM Norton net Security 2011 - Symantec 21076753 1 

272-0291 Cable CAT.6a SSTP patch 0.3m - RoHS 1 

620-0142 LCH assembly - 8184-000-01-A3 1 

280-4198 Cable BNC to BNC 3 m - RoHS 1 

820-0216 LCH 48V Power Test Cable Assy - 8184-015-A1 1 

820-0072 Subsea Lodestar Comms Ethernet - 8084-138-04-A3 1 



 

User Manual for SPRINT UM-8253-000
Issue A Rev 3

 

 

Section 14 
15 November 2013 102 

Stock Code Description Quantity 

820-0078 Subsea Lodestar TCVR Test - 8084-139-04-A2 2 

620-0203 SPRINT Software - 8253-006-A 1 

8084-3110 Lodestar 3K 5-CONN - 8084-000-3110-B1 1 

317-5404 CON U/W 6W I/L MP MICRO 2 

790-1135 Subsea Lodestar Transit Case 1 

317-5383 Con U/W 8W I/L FS Micro 1 

317-5384 Con U/W 8W I/L MP Micro 2 

317-5385 Con impulse locking sleeve 5 

820-0067 Lodestar Subsea Console Test - 8084-136-04-A2a 1 

820-0070 Subsea Lodestar comms C1 TEST - 8084-137-04-A2a 1 

998-0137 Subsea Gyro drilling template - 8146-200-A2 1 

620-7214 Lodestar-2 software CD - 8084-114-C1 1 
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APPENDIX A – LODESTAR ANGLE DEFINITIONS 

A Euler angles (Tate Bryan Rotations) 

The “Tate Bryan” rotations given hereafter are commonly and henceforward referred to as the Euler 
angles even though they are formally just a specific sequence of a larger set of possible Euler 
angle rotation sequences. The Euler angle rotation sequence from NED (Earth Frame; x-North, y-
East, z-Down) to body frame is: 

1. Rotation by the heading angle ϕ (phi) about Zned.  

2. Rotation by the pitch angle θ (theta) about the resulting Y axis.  

3. Rotation by the roll angle ψ (psi) about the resulting X axis.  

Similarly, the rotation sequence from a reference frame (ROV) to a sensor frame (IMU, USBL, DVL) 
is: 

1. Rotation by the gamma angle about Zref.  

2. Rotation by the beta angle about the resulting Y axis.  

3. Rotation by the alpha angle about the resulting X axis.  

A.1 Heading (Azimuth, Yaw) 
Heading is the angle between Xned and the projection of Xb into the horizontal plane (XYned) 
measured about Zned. Heading is in the interval [0º ... 359.999º], Yaw is in the interval [-179.999º 
... +180.000º]. 

A.2 Pitch  
Pitch is the angle between Xb and the horizontal plane (XYned). Pitch is positive when Xb is 
pointed above the horizontal plane. Pitch angle lies in the interval [-90º ... +90º]. 

A.3 Roll 
Roll is the angle between Yb and the horizontal plane measured in the ZYb plane. Roll is positive 
when Yb is pointed below the horizontal plane. Roll angle lies in the interval [ -180º ... +180º]. 

A.4 Gravity (Datawell) Angles 
Gravity angles are typically returned by a gyro and traditional VRUs measuring the angle of the 
gravity vector using 2 independent orthogonally mounted tilt sensors e.g. Datawell, TSS or Watson 
VRUs. These are generally defined as follows: 

A.5 Pitch 
Angle between the vessel forward axis and the horizontal, positive when bow is pointed above 
horizontal. 
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A.6 Roll 
Angle between the vessel starboard axis and the horizontal, positive when starboard is pointed 
below horizontal. 

A.7 Heading 
Angle from the North axis to the vertical projection of the vessel forward axis onto the horizontal, 
measured about the down axis. 
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APPENDIX B – REFERENCE FRAMES AND ANGULAR 
CONVENTIONS 

B Reference Frames and Angular Conventions 

B.1 Lodestar Frame 
The Lodestar frame is a fixed right-hand coordinate frame X Y Z. Typically Lodestar is mounted so 
that the X axis is approximately coincident with vehicle forward; the Y axis is coincident with vehicle 
starboard; and the Z axis is coincident with vehicle down.  

Lodestar has the X and Y directions displayed on the top of the unit as an orientation aid during 
installation. Additionally, all measurements involving the Lodestar should be made with respect to 
the unit’s centre of axis (see Lodestar Hardware Manual UM-8084-101). 

Lodestar angular outputs are defined in Gravity (or Datawell) angles; see Appendix A for further 
details. 

Figure B─1 – Lodestar Reference Frame 

 
 

 Y Axis Positive (+) Starboard   X Axis Positive (+) Forward 

 Orientation Marks (Forward)   Z Axis Positive (+) Down 
 

B.2 Vehicle Reference Frame 
For most applications, measurements are required with respect to the vehicle’s reference frame. 
The definition of the vehicle reference frame is shown below. 

Unless otherwise stated for a particular output telegram, the Lodestar will output measurements 
with respect to this frame. 

Before installing the Lodestar it is important to understand the concept of the vehicle reference 
frame. Often the chosen centre of a vehicle’s reference frame is its centre of motion or mass and is 
usually defined and documented prior to the installation of equipment such as the Lodestar. The 
centre of the vehicle’s reference frame is often referred to as the CRP or central reference point. 



 

User Manual for SPRINT UM-8253-000
Issue A Rev 3

 

 

Appendix B  
15 November 2013 106 

In a typical installation, the Lodestar may not be perfectly aligned to the installation vehicle 
reference frame. 

Figure B─2 – Vehicle Reference Frame 

 
 

 Positive Pitch (Bow up)   Down (Z) 

 Starboard (Y)   Positive Roll (Starboard Down) 

 Positive Heading Change   Forward (X) 
 

B.3 Mounting Angles 
In some cases, for the Lodestar to output measurements that are correct for the vehicle reference 
frame, mounting angles in the three axes must be carefully measured and configured. 

The rotation sequence from a reference frame (vehicle) to the actual Lodestar frame is: 

1. Rotation by the C (Heading) angle about the Z axis of the reference frame. 

2. Rotation by the B (Pitch) angle about the resulting Y axis.  

3. Rotation by the A (Roll) angle about the resulting X axis. 

NOTE 

 Only the misalignment for angle C (heading) can be measured independently. The 
misalignments for angles B (pitch) and A (roll) are the resultant misalignments after the 
preceding misalignments have been applied. 

Mounting angles are specified as Euler angles; see Appendix A for further details. 
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The convention for measuring each mounting angle is shown below.  

NOTE 

 To simplify the definition and convention of each mounting angle, each angle is 
depicted independently but in practice they are non-commutative and must be measured in 
the order defined previously. 

Figure B─3 – Lodestar Heading Mounting Angle Example 

 
 

 Heading Output (Mounting Angle +40°)   Heading Output (Mounting Angle 0°) 

 Positive (+) Mounting Angle Applied    
 

Figure B─ 4 – Lodestar Pitch Mounting Angle Example 

 
 

 Pitch Output (Mounting Angle 0°)  Pitch Output (Mounting Angle +30°) 

 Positive (+) Mounting Angle Applied    
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Figure B─ 5 – Lodestar Roll Mounting Angle Example * 

 
 

 Roll Output (Mounting Angle 0°)  Roll Output (Mounting Angle +30°) 

 Positive (+) Mounting Angle Applied    
 

*Vehicle view is bow-on. 
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APPENDIX C – LODESTAR MOUNTING ANGLE EXAMPLES 

C Lodestar Mounting Angle Examples 

This section provides some examples of alternate Lodestar mountings and the associated “coarse” 
mounting angles that should be used in the system configuration. 

Configuration A 

If the Lodestar is mounted in the following configuration:  

 

Then use the following mounting angles on the Lodestar configuration page: 

Heading:   0 

Resulting Pitch:  90 

Resulting Roll:  0 

Configuration B 

If the Lodestar is mounted in the following configuration:  

 

Then use the following mounting angles on the Lodestar configuration page: 

Heading:   180 

Resulting Pitch:  -90 

Resulting Roll:  0 
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Configuration C 

If the Lodestar is mounted in the following configuration:  

 

Then use the following mounting angles on the Lodestar configuration page: 

Heading:   0 

Resulting Pitch:  -90 

Resulting Roll:  0 

Configuration D 

If the Lodestar is mounted in the following configuration:  

 

Then use the following mounting angles on the Lodestar configuration page: 

Heading:   180 

Resulting Pitch:  90 

Resulting Roll:  0 
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APPENDIX D  – RECOMMENDED DVL CONFIGURATIONS 

D Recommended DVL Configuration 

Please contact Sonardyne Support if your DVL configuration is not listed (e.g. PD0). 

D.1 RDI DVL PD4/5 (Triggered) 

 CR1 

 CB811 

 CF11110 

 CX1 

 CT1 

 BK0 

 EX01010 

 EZ0000001 

 PD4 (or PD5) 

 TE00:00:00.00 

 TP00:00.00 

 CK 

 CS 

D.2 RDI DVL PD4/5 (Non-Triggered) 

 CR1 

 CB811 

 CF11110 

 CX0 

 CT1 

 BK0 

 EX01010 

 EZ0000001 

 PD4 (or PD5) 

 TE00:00:00.00 

 TP00:00.00 

 CK 

 CS 
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APPENDIX E – SPRINT MESSAGE DEFINITIONS 

E Introduction 

This section lists messages that are specific to the SPRINT (INS) system input and output. Other 
messages are available for output, such as Lodestar AHRS output messages. These are listed 
manual 8084-109 AHRS Messages. 

Table E-1 – SPRINT Input & Output Messages 

Message INS Input INS Output 

GGA 
 

GPGGA 
NPGGA 

 
INGGA 

PSIMSSB   

DVL PD4   

DVL PD5   

DigiQuartz Pressure Depth   

Valeport Midas SVX2 Depth   

PSONDEP Depth   

NMEA DPT Depth   

ZDA   

Valeport Sound Velocity   

PSONSS Sound Velocity   

INS Navigation   

INS Navigation Quality   

Time System   
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E.1 Simrad SSB – SSBL Position Report ($PSIMSSB) 
Reference: Kongsberg APOS Release 4.2.2 Manual (29.April. 2005) 

E.1.1. Description 

The PSIMSSB sentence contains the position of a SSBL beacon which is sent after each USBL 
measurement. The operator may define various parameters. 

E.1.2. Format 

$PSIMSSB,hhmmss.ss,cc__,A,cc__,a,a,a,x.x,x.x,x.x,x.x,a,x.x,x.x*hh <cr><lf> 

Table E-2 – PSIMSSB Formatting 

Field Description 

$ Start character 

PSIM Proprietary Simrad code 

SSB Sentence Formatter 

,hhmmss.ss Empty or UTC time of reception 

,cc_ Beacon code, Examples: B01, B33, B47 

,A Status, A for OK, V for not OK 

,cc_ Error_code, Empty or 3 character error code 

,aa_ C for Cartesian, P for polar, U for UTM coordinates, R for radians 

,aa_ Orientation, H vessel head up; N for north; E for East: 

 ,aa_ Software filter, M=Measured, F=Filtered, P=Predicted 

 ,x.x x coordinate 

 ,x.x y coordinate 

 ,x.x Depth in metres 

 ,x.x Expected accuracy of the position 

 ,aa_ 
Additional info, N=none,C= compass, I=inclinometer, T=Time from 
Beacon to Transceiver 

 ,x.x First add value, empty or Tp compass or Tp x inclination 

 ,x.x Second add value, empty or Tp y inclination. 

*hh Terminator and checksum (or empty ?) 

<CR><LF> return plus linefeed  
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E.1.3. Supported Input Format 

Sonardyne Marksman/Ranger 2 and Kongsberg HiPAP: 

 
 

E.2 Proprietary $PSONDEP Report 

E.2.1. Description 

The purpose of this proprietary string is to support depth input into Sonardyne software and 
instruments from a non-specific source. This string is already used in several subsea positioning 
applications with both Ranger and Fusion software. 

E.2.2. Format 

$PSONDEP,x.xx,y.y,c*hh<CR><LF> 

Table E-3 – PSONDEP Formatting 

Field Description 

$ Start_character 

PSONDEP Address 

,x.xx Depth 

,y.y Observation Error 

,c  Units (M=metres) 

*hh Terminator and Checksum 

 <cr><lf> Termination (0x0D 0x0A) 

 

E.2.3. Supported Input Format 
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E.3 Proprietary $PSONSS Report 

E.3.1. Description 

The purpose of this proprietary string is to support sound speed input into Sonardyne software and 
instruments from a non-specific source. This string is already used in several subsea positioning 
applications with both Ranger and Fusion software. 

E.3.2. Format 

$PSONSS,x.x,y.y,c*hh<CR><LF> 

Table E-4 – PSONSS Formatting 

Field Description 

$ Start_character 

PSONSS Address 

,x.x Depth 

,y.y Sound Speed in Units per second 

,c  Units 

*hh Terminator and Checksum 

 <cr><lf> Termination (0x0D 0x0A) 

 

E.3.3. Supported Input Format 

 
 

E.4 Digiquartz Pressure Sensor Report 

E.4.1. Description 

Pressure depth output from Paroscientific Digiquartz intelligent pressure depth sensor. 

E.4.2. Format 

*0001nnn__<CR><LF> 

Table E-5 – Digiquartz Formatting 

Field Description 

* Start character 

00 Destination ID (00 is ID of serial host) 

01 Source ID (01 is ID of sender device) 

nnn___ Measurement Data (units=Metres H2O / KPA / PSI) 

<CR><LF>   return plus linefeed  
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E.4.3. Supported Input Format 

 
 

E.5 $__DPT Report 

E.5.1. Description 

This is NMEA string outputs water depth. 

E.5.2. Format 

$__DPT,x.x,y.y,z.z*hh<CR><LF> 

Table E-6 – DPT Formatting 

Field Description 

$ Start_character 

__DPT Address 

,x.x Water depth relative to the transducer, in metres 

,y.y Offset from transducer, in metres. (NOT USED) 

,z.z Maximum range scale in use 

*hh Terminator and Checksum 

 <cr><lf> Termination (0x0D 0x0A) 

 

E.5.3. Supported Input Format 

 
 

E.6 Valeport Sensor Telegram 

E.6.1. Description 

This simple string outputs the data from the Valeport Mini SVS sensor. Sound Velocity only m/sec 
supported. 
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E.6.2. Format 

<space>1234.567<CR><LF> 

Table E-7 – Valeport Sensor Telegram Formatting 

Field Description 

<space> A space character 

x.x Sound Speed in metres per second 

 <cr><lf> Termination (0x0D 0x0A) 

 

E.6.3. Supported Input Format 

 
 

E.7 $__GGA Report 

E.7.1. Description 

This NMEA string outputs longitude and latitude at a UTC time. 

E.7.2. Format 

$--GGA, hhmmss.ss,llll.ll,a,yyyyy.yy,a,x,xx,x.x,x.xxx,M,x.x,M,x.x,xxxx*hh<CR><LF> 
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Table E-8 – GGA Formatting 

Field Description 

$ Start character 

-- Sender Code (IN ? or GP) 

GGA Sentence Formatter 

hhmmss.ss UTC 

llll.ll,a 
Latitude, N/S     2 fixed digits degrees, 2 fixed digits minutes, variable 
digits of decimal minutes. 

yyyyy.yy,a 
Longitude, E/W     3 fixed digits degrees, 2 fixed digits minutes, variable 
digits of decimal minutes. 

x GPS quality Indicator 0-8 

xx Number of satellites 

x.x Horizontal dilution of precision 

x.xxx,M 
 Antenna altitude above/below mean sea level (geoid), Metres (units of  
antenna altitude) 

 x.x,M Geoidal Separation, Metres 

 x.x   Age of Differential data, not relevant. 

 xxxx   Differential Reference Station ID 

 *hh   Terminator and checksum 

 <CR><LF>   Terminator, return plus linefeed  

 

E.7.3. Supported Input Formats 

Sonardyne Ranger: 

 
 
EIVA NaviPac: 
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E.8 $__ZDA Report 

E.8.1. Description 

This NMEA string outputs UTC,day,month,year and local time zone. 

E.8.2. Format 

$--ZDA,hhmmss.sss,xx,xx,xxxx,xx,xx*hh <cr><lf> 

Table E-9 – ZDA Formatting 

Field Description 

$ Start character 

-- Sender Code 

ZDA Sentence Formatter 

,hhmmss.sss Hours, minutes, seconds, and decimal seconds 

,xx  Day, 0 to 31 

,xx Month, 01 to 12 

 ,xxxx Year 

 ,xx  Local Zone hours  00 to ±13  

 ,xx Local Zone minutes 00 to 59 

 *hh Terminator and checksum 

<CR><LF> return plus linefeed  

 

E.8.3. Supported Input Format 

 
 

E.9 Navigation (Nav) Data 
The navigation (Nav) data message is the generic navigation output from Lodestar AINS and is 
closely related the navigation quality message (NavQual), refer to Table E-8 – GGA Formatting.  

NOTE 

 Nav and NavQual are intended for advanced users including internal (Sonardyne) and 
external system integrators. Nav values are valid for vehicle CRP / frame, except 
acceleration which is valid for the IMU zero point but expressed in vehicle frame. For best 
accuracy it is recommended to use CRP=IMU zero point. AINS algorithm is the only source 
for the NAV message. 
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Table E-10 – Navigation Data 

Byte# 
Field 
name 

Unit (LSB) 
Data 
type 

Note 

0-5 / 6 timeTag 1e-6 sec  Uint48 System time 

6-9 / 4 lat 2^-31*90 x° [-90;90] Int32 +North (LSB ~= 0.5cm) 

10-13 / 4 lon 2^-31*180° [-180; 180] Int32 +East (LSB ~= 1cm @ Equator) 

14-17 / 4 depth 1e-3 m Int32  

18-19 / 2 altitude 1e-2 m Uint16 Height above seabed (from DVL) 

20-21 / 2 roll 2^-15*180° [-180; 180] Int16 
Angle between y and horizontal. Roll is 
positive when y is pointed below the 
horizontal (starboard down) 

22-23 / 2 pitch 2^-15*180° [-90;90] Int16 
Angle between x and horizontal. Pitch 
is positive when x is pointed above the 
horizontal (bow up) 

24-25 / 2 heading 2^-15*180° [0;360] Uint16
Angle between North and projection of 
X onto the horizontal (measured about 
down).  

26-27 / 2 vx  1e-3 m/s Int16 X-velocity (max ~32m/s) 

28-29 / 2 vy - - - 

30-31 / 2 vz - - - 

32-33 / 2 wx 1e-2°/s Int16 
Angular rate about x axis (max 
~327°/s) 

34-35 / 2 wy - - - 

36-37 / 2 wz - - - 

38-39 / 2 ax 1e-3 m/s^2 Int16 X-acceleration (max ~ 3.2 G) 

40-41 / 2 ay  - - 

42-43 / 2 az  - - 

44-45 / 2 mode N/A Bit16 

Logical. Bit# 
0: data valid  
1:INS initialised 
2: INS application not enable 
3-14: Reserved 
15: System failure 

 

NOTE 

 Altitude = 0 imply invalid. 
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E.10 Navigation Quality Estimate (NavQual) 
The navigation quality message reports the expected accuracy of the data given in the “nav” 
message. 

NOTES 

 Horizontal position 1DRMS = sqrt(posMajor^2 + posMinor^2). 

 CEP(50%) ~= 0.589 * (posMajor + posMinor). 

 Error ellipse (1 sigma) is 39.4% probability (i.e. 39.4% likelihood that true value is within 
ellipse). 

 95% percent probability error ellipse is 2.447 * 1 sigma error ellipse. 

 Roll, pitch 1 sigma ~= max(stdLevN,stdLevE) for roll, pitch << 45deg. 

 Velocity rms = sqrt(velMajor^2+ velMinor^2). 

Table E-11 – Navigation Quality Estimate – Rate: 1 Hz 

Byte# Field name Unit (LSB) / range 
Data 
type 

Note 

0-5 / 6 timeTag 1e-6 sec Uint48 System time 

6-9 / 4 posMajor m Float32
Position (horizontal) error ellipse: 
- semi-major axis (1 sigma) 

10-13/ 4 posMinor - Float32 - semi-minor axis (1 sigma) 

14-17 / 
4 

dirPMajor deg [0;360[ Float32 - direction of semi-major axis 

18-21 / 
4 

stdDepth m Float32 Depth (1 sigma) 

22-25 / 
4 

stdLevN deg Float32 Level error about North (1 sigma) 

26-29 / 
4 

stdLevE deg Float32 Level error about East (1 sigma) 

30-33 / 
4 

stdHeading deg Float32 Heading (1 sigma) 

34-37 / 
4 

velMajor m/s Float32
Velocity (horizontal) error ellipse: - 
semi-major axis (1 sigma) 

38-41 / 
4 

velMinor m/s Float32 - semi-minor axis (1 sigma) 

42-45 / 
4 

dirVMajor deg [0;360[ Float32 - direction of semi-major axis 

46-49 / 
4 

velDown m/s Float32 Down velocity (1 sigma) 
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E.11 Time System Data 
The Time System data format is defined below. 

NOTES 

 Source of RTC to UTC update; 0 = NO SOURCE; 1 = LODESTAR RTC; 2 = Standalone 
GPZDA; 3 = Standalone GPGGA; 4 = GPZDA 1PPS. 

 Fields in italic are for advanced users only and are subject to change. 

Table E-12 – Time System Data 

Field
# 

Byte# 
(from 0) 

Size 
(bytes)

Field name Unit/LSB 
Data 
type 

Notes 

1 0-5 6 sysTime 1e-6 sec Uint48 
System time (and 
message timeTag) 

2 6-13 8 utcTime 1e-6 sec Uint64 
UTC time – seconds since 
midnight 1970.01.01 

3 14-19 6 timeSinceUpdate 1e-6 sec Uint48 
Time since last accepted 
UTC time update, e.g. 
from ZDA/PPS 

4 20-23 4 stdDev sec Float32 
Expected standard 
deviation of UTC time 
field 

5 24 1 Source logical  Uint8 
Currently used source of 
UTC sync 

6 25 1 ppsRising logical Uint8 

0: PPS valid on falling 
edge  
    (low to high voltage). 
1: PPS valid on rising 
edge. 

7 26 1 zdaCount # Uint8 
LS byte of ZDA message 
count 

8 27 1 ppsCount # Uint8 
LS byte of PPS message 
count 

9 28 1 zdaRejCount # Uint8 
LS byte of ZDA message 
rejection count 

10 29 1 ppsRejCount # Uint8 
LS byte of PPS  signal 
rejection count 

11 30 1 ppsZdaProcCount # Uint8 
LS byte of accepted 
PPS/ZDA pairs 

12 31 1 filtResetCount # Uint8 
LS byte of UTC filter reset 
count 
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Example: Converting IMU time tag from [sys] to [utc] 

imu.timeTag[sys] = 1234567890 usec 

Get the preceding time system message: 

timeSys.sysTime = 1234101010 usec 

timeSys.utcTime = 1254273030984001 usec 

timeSys.stdDev = 0.0000124 sec    low std.dev. => UTC can be trusted 

imu.timeTag [utc] = imu.timeTag[sys] + (timeSys.utcTime - timeSys.sysTime) 

= 1234567890 + (1254273030984001 - 1234101010) usec 

= 1254273031450881 usec = 20090930T011031 (ISO 8601) = 2009-09-30 01:10:31 

E.12 Midas SVX2 Depth 

E.12.1. Description 

This message is tab delimited and provides Sound Velocity, Depth, Temperature and 
conductivity. 

E.12.2. Format 

ssss.sss<tab>uuuu<tab>dddd.ddd<tab>xxxx<tab>tttt.ttt<tab>xxxx<tab>cccc.ccc<tab>zzzz<cr><lf> 

E.12.3. Table 

Field Description 

ssss.sss Sound Velocity in metres per second 

uuuu Sound Velocity Units (M/SEC) 

dddd.ddd Depth 

xxxx Depth Units (DBAR) 

tttt.ttt Temperature 

xxxx Temperature Units (C) 

cccc.ccc Conductivity 

zzzz Conductivity Units (MS/CM) 

<CR><LF> return plus linefeed  

E.12.4. Supported Input Format 
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APPENDIX F – SPRINT WIRING DIAGRAM 

F Typical Wiring Diagram 

Figure F─1 – Typical SPRINT Wiring Diagram 
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APPENDIX G – PRESSURE TO DEPTH CONVERSION 

Pascal to Metres: 0.00009938710 

PSI to Pascals: 6894.757293168361 
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APPENDIX H – SPRINT INSTALL & SETUP CHECKLIST 

Post-Transit Checks Yes No Notes 

 

Prior to installation on the vehicle has the Lodestar been powered and 
connected to the SPRINT topside (PC & LCH) to check operation and basic 
communication?    

Vehicle Checks Yes No Notes 

Vehicle Vehicle CRP defined and identifiable?    

 
Is Lodestar mounted rigidly and away from any source of vibration or (non-
vehicle frame) independent movement?    

 
[Serial] Vehicle MUX connection configured/available @ 115,200 baud 
rate?    

 [Ethernet] Vehicle MUX connection configured/available @ 100 Mbit?    

 Cable connection wired as per system wiring diagram?    

 [Serial] 232/485 select pin wired correctly?    

 Powered by either 24 or 48 V?    

 Offsets from vehicle CRP to Lodestar 'Centre of Axis' measured (Metres)?   Forward:___________ 

    Starboard:__________ 

    Down:_____________ 
 1000 m Rated Lodestar: 

    
 3000 m Rated Lodestar: 

    
 5000 m Rated Lodestar: 
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Mounting Angles from vehicle frame to Lodestar frame measured 
(Degrees)?NB: Not required if Lodestar mounted nominally: Connectors 
are uppermost on Lodestar and 'X' orientation mark is aligned with forward 
direction of vehicle body   Heading:___________ 

    Pitch:_____________ 

    Roll:______________ 

USBL 
Offsets from vehicle CRP to USBL beacon (centre of transducer) 
measured (Metres)?   Forward:___________ 

    Starboard:__________ 

    Down:_____________ 

 
If multiple USBL beacons present, has acoustic check been run on the 
SPRINT aiding beacon to confirm correct address and offsets? 

   

 
If SPRINT aiding beacon is responder, has responder trigger been 
checked? 

   

Depth 
Offsets from vehicle CRP to depth sensor (point of measurement) 
measured (Metres)?   Forward:___________ 

    Starboard:__________ 

    Down:_____________ 

 Cable connection wired as per system wiring diagram?    

 Sensor powered?    

 
If multiple depth sensors present, has check been run on the SPRINT 
aiding sensor to confirm correct offsets?    

 
Has output format been checked (for compatibility) prior to connection with 
Lodestar or SPRINT?   Format:____________ 

    Units:______________ 

 Have serial settings been checked?   Baud Rate:_________ 

    Data Bits:__________ 

    Stop Bits:__________ 

    Parity:_____________ 

LBL Offsets from vehicle CRP to the LBL Transducer measured (Metres)?   Forward:___________ 

    Starboard:__________ 

    Down:_____________ 

 Cable connection wired as per system wiring diagram?    

 Sensor powered?    

 
If LBL transducers present, has check been run on the SPRINT aiding 
sensor to confirm correct offsets?    

DVL 
Offsets from vehicle CRP to DVL (centre of transducer faces) measured 
(Metres)?   Forward:___________ 

    Starboard:__________ 

    Down:_____________ 

 Cable connection wired as per system wiring diagram?    

 
DVL facing down with alignment mark facing forward on the vehicle? 
NB: Misalignments can be calculated by the DVL calibration procedure    

 
Is DVL triggered by Lodestar? (If no then DVL will be free-running / 
untriggered)    

 DVL powered?    

 
If multiple DVLs present, has check been run on the SPRINT aiding DVLto 
confirm correct offsets?    

 
Can DVL be auto-configured by SPRINT (customer does have a specific 
output requirement?)    

 If No:    

  Has configuration been checked (for compatibility) prior to 
connection with Lodestar?   Format:____________ 

    Units:______________ 
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  Have serial settings been checked?   Baud Rate:_________ 

    Data Bits:__________ 

    Stop Bits:__________ 

    Parity:_____________ 

Is position output from SPRINT required from a point other than the vehicle 
CRP?    

If Yes:    

Remote 
Output 
Points 

Offsets from vehicle CRP to remote point(s) measured (Metres)?   Forward:___________ 

    Starboard:__________ 

    Down:_____________ 

Topside Checks Yes No Notes 

LCH Is LCH powered?    

 Is LCH connected to the SPRINT PC?    

 Can the LCH Admin Page be opened?    

Lodestar [Serial] Is Lodestar connected to serial port 1 on the LCH?    

 [Ethernet] Is Lodestar connected to Ethernet port 2 on the LCH?    

 
Has the default/work site Latitude been set in the SPRINT software 
(Lodestar)?    

 
Has the Lodestar shutdown delay been checked in the SPRINT Software 
(Lodestar)?    

 
Have the Lodestar offsets been configured in the SPRINT Software 
(Lodestar)?    

 
Have the Lodestar mounting angles been configured in the SPRINT 
Software (Lodestar)?    

Has output format been checked (for compatibility) prior to connection with 
SPRINT?   

Format 
(GPZDA):__________ 

Time 
Synch 

Have serial settings been checked?   Baud Rate:_________ 

    Data Bits:__________ 

    Stop Bits:__________ 

    Parity:_____________ 

 
Has the LCH ZDA serial port been checked/configured with the correct 
serial settings?    

 Is GPZDA output @ 1Hz?    

 Does GPZDA message contain UTC time and date?    

 Is the latency between the GPZDA and the actual UTC time known?    

 
Has the Time Synch been configured in the SPRINT software (Time 
Synch)?    

USBL 
Has output format been checked (for compatibility) prior to connection with 
SPRINT?   Format:____________ 

 Have serial settings been checked?   Baud Rate:_________ 

    Data Bits:__________ 

    Stop Bits:__________ 

    Parity:_____________ 

 
Has the LCH USBL serial port been checked/configured with the correct 
serial settings?    

 Is USBL position in WGS84 Latitude Longitude?    

 
Is the USBL position the 'raw' USBL position and not corrected for offsets 
or filtered/smoothed?    

 Does USBL message contain UTC timestamp?    

 
Does USBL message contain USBL quality? 
NB: Quality field in PSIMSSB message or in certain applications HDOP 
field in USBL GGA message is populated with USBL quality 

   

 If No:    
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Has the manual USBL quality value been configured in the SPRINT 
Software (USBL Input)? 

   

 

Does USBL feed contain messages for multiple beacons identified by 
beacon ID? 
NB: Beacon ID field in PSIMSSB message or in certain applications 
reference station ID in USBL GGA message is populated with beacon ID 

   

 If Yes:    

 
Has the USBL beacon ID filter been configured in the SPRINT Software 
(USBL Input)? 

   

 
Have the USBL beacon offsets been configured in the SPRINT Software 
(USBL Input)? 

   

 
Has the USBL type been configured in the SPRINT Software (USBL 
Input)? 

   

Depth 
Has output format been checked (for compatibility) prior to connection with 
Lodestar or SPRINT?   Format:____________ 

    Units:______________ 

 If Depth sensor feed is connected to Topside (not Lodestar):    

 Have serial settings been checked?   Baud Rate:_________ 

    Data Bits:__________ 

    Stop Bits:__________ 

    Parity:_____________ 

 
Has the LCH USBL serial port been checked/configured with the correct 
serial settings?    

 
Has the correct port been specified and configured if depth sensor is 
connected directly to the Lodestar?    

 Does a surface correction need to be applied?    

 
Have the depth sensor offsets been configured in the SPRINT Software 
(Depth Input)?    

 
Has the Depth type and units been configured in the SPRINT Software 
(Depth Input)?    

DVL Has the correct Lodestar port been specified in the SPRINT software (DVL) 
   

 Has the DVL been auto-configured by the SPRINT software?    

 Yes    

 Has the DVL been 'deployed' after the auto-configuration?    

 No    

 
Have the Lodestar port settings been configured to match the DVL serial 
settings?    

 
Has the correct 'triggered by Lodestar' setting been configured in the 
SPRINT Software (DVL)    

 
Has the correct 'Binary or Hex ASCII' setting been configured in the 
SPRINT Software (DVL)    

 
If a new installation, have the default DVL mounting angles been 
configured in the SPRINT software (DVL)   Heading:________135 

    Pitch:___________0.0 

    Roll:_________-179.9 

 
If a new installation have the latency and scale factor values been set to 
zero (default) in the SPRINT software (DVL)    

 Have the DVL offsets been configured in the SPRINT Software (DVL)?    

Has the correct Sound Velocity type been specified in the SPRINT software 
(Sound Velocity)?    Sound 

Velocity 
Yes (automatic DVL derived to be used)    

 
Has the salinity value been checked/set in the SPRINT software (Sound 
Velocity)?    

 Yes (Manual)    

 
Has the manual sound velocity be set in the SPRINT software (Sound 
Velocity)?    
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 Yes (Sound velocity message feed to be used)    

 
Has input format been checked (for compatibility) prior to connection with 
SPRINT?   Format:___________ 

 Have serial settings been checked?   Baud Rate:_________ 

    Data Bits:__________ 

    Stop Bits:__________ 

    Parity:_____________ 

 
Has the LCH serial port been checked/configured with the correct serial 
settings?    

 
Sound Velocity sensor offsets are optional - have they been configured in 
the SPRINT Software (Sound Velocity)?    

LBL 
Have the serial settings for the INS port been checked in the Fusion 
software?   Baud Rate:_________ 

    Data Bits:__________ 

    Stop Bits:__________ 

    Parity:_____________ 

 
Have the serial settings for the Fusion INS port been checked in the 
SPRINT software?   As above 

 
Have the serial settings for the LBL port been checked in the Fusion 
software?   Baud Rate:_________ 

    Data Bits:__________ 

    Stop Bits:__________ 

    Parity:_____________ 

 
Have the serial settings for the Fusion LBL port been checked in the 
SPRINT software?   As above 

 
Have the LBL transceiver AND Lodestar offsets been configured in the 
Fusion Software?    

 
Has the transceiver Comms Reset been set to "None" in the Fusion 
software (Transceiver Advanced)?    

 Has the transceiver connection been tested in Fusion (Get or Get All)?    

Is position output from SPRINT required from a point other than vehicle the 
CRP?    

Remote 
Output 
Points If Yes:    

 
Have remote point(s) offsets been configured in the SPRINT software 
(Remote Points)?    

Outputs 
Have Lodestar (direct) outputs been configured in the SPRINT software 
(Lodestar Outputs)?    

 
Have PC/LCH outputs been configured in the SPRINT software (PC/LCH 
Outputs)?    

INS 
Have the correct INS aiding options been specified in the SPRINT software 
(INS Aiding)?    
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APPENDIX I – SOFTWARE COPYRIGHT / LICENSE / 
WARRANTY 

SOFTWARE COPYRIGHT / LICENSE / WARRANTY 

All rights reserved. 

This license applies to the registered version of UTILITIES TEST PROGRAMS, known below as 
the SOFTWARE PRODUCT.  

LICENSE AGREEMENT 

You should carefully read the following terms and conditions before using this software. Unless you 
have a different license agreement signed by Sonardyne International Limited your use of this 
software indicates your acceptance of this license agreement and warranty disclaimer.  

REGISTERED VERSION 

One registered copy of the SOFTWARE PRODUCT may either be used by a single person who 
uses the software personally on one or more computers, or installed on a single workstation used 
non simultaneously by multiple people, but not both.  

COPYRIGHT 

All rights, title, and copyrights in and to the SOFTWARE PRODUCT and any copies of the 
SOFTWARE PRODUCT are owned by Sonardyne International Limited. The SOFTWARE 
PRODUCT is protected by copyright laws and international treaty provisions. Therefore, you must 
treat the SOFTWARE PRODUCT like any other copyrighted material, except that you may either  

make one copy of the SOFTWARE PRODUCT solely for backup or archival purposes, or  

install the SOFTWARE PRODUCT on a single computer, provided you keep the original solely for 
backup or archival purposes. You may not copy the printed materials accompanying the 
SOFTWARE PRODUCT. 

DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS  

You may not reverse-engineer, decompile, or disassemble the SOFTWARE PRODUCT, except 
and only to the extent that such activity is expressly permitted by applicable law not withstanding 
this limitation.  

No registered user may alter or modify the Software except as detailed in the Special Conditions 
below. You cannot give anyone else permission to modify the Software.  

You may not rent, lease or lend the SOFTWARE PRODUCT unless specifically authorised in 
advance by Sonardyne International. Where onward rental, lease or loan is sanctioned by 
Sonardyne International, the end user must be made aware of the details of this agreement and it is 
the responsibility of the rentee to ensure that the end user complies with the agreement and deletes 
and returns any copies at the end of the rental period. 

You may not transfer any of your rights under this agreement. 

Without prejudice to any other rights, Sonardyne International Ltd. may terminate this agreement if 
you fail to comply with the terms and its conditions. In such event, you must destroy all copies of 
the SOFTWARE PRODUCT and all of its component parts. 

GOVERNING LAW 

This agreement shall be governed by English law.  
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DISCLAIMER OF WARRANTY 

THIS SOFTWARE PRODUCT AND THE ACCOMPANYING FILES ARE RECEIVED “AS IS” AND 
WITHOUT WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER 
WARRANTIES WHETHER EXPRESSED OR IMPLIED. Because of the various hardware and 
software environments into which the SOFTWARE PRODUCT may be put, NO WARRANTY OF 
FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.  

Good data processing procedure dictates that any program be thoroughly tested with non-critical 
data before relying on it. The user must assume the entire risk of using the program. ANY 
LIABILITY OF SONARDYNE INTERNATIONAL LIMITED WILL BE LIMITED EXCLUSIVELY TO 
PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.  

SPECIAL CONDITIONS 

The user is allowed to modify data files, as described in the operating instructions, to suit his own 
custom test routines.  

Copyright © Sonardyne International Limited 2013 
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GLOSSARY OF TERMS 

Term Definition 

Attitude and Heading 
Reference System (AHRS) 

An inertial sensor that provides outputs of heading, pitch and roll. 

Doppler Velocity Log (DVL) 
A DVL bounces sound off the bottom (or a reference layer of water) 
and can determine the velocity vector of a subsea vehicle (or surface 
vessel) moving across the sea floor 

Global Positioning System 
(GPS) 

A multi-user, 24-hour, worldwide radio navigation system using the 
NAVSTAR constellation of satellites. GPS receivers are capable of 
tracking and decoding data from the satellites and using it to 
compute the position and velocity of a vehicle.  

Inertial Navigation System 
(INS) 

A navigation aid that uses a computer, motion sensors and rotation 
sensors to continuously calculate the position, orientation and 
velocity of a moving object without the need for external references. 

Long Base Line Positioning 
System (LBL) 

A system where two or more beacons are on the seabed. The 
positions of the beacons are established by a calibration process in a 
seabed frame. The distances from a transducer to each beacon are 
measured using a transceiver. The position of the transducer can be 
computed in the seabed frame. The name comes from the 
“baselines” joining each beacon.  

Subsea Precision 
Reference Inertial 
Navigation Technology 
(SPRINT) 

An acoustically aided inertial navigation system for subsea vehicles. 
The system extends the operating limits of USBL and improves the 
operational efficiency of LBL by using sparse arrays. 

Ultra Short Base Line 
Positioning System (USBL) 

A system similar to an SBL system except the system uses three or 
more elements in a single transducer array. The measurements it 
makes are the differences in “time-phase” of the signals from each 
element. The co-ordinate frame is fixed to the transducer array which 
must be oriented in the vessel frame to be equivalent to the SBL. 
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